Leica Confocal 
Software LCS

User manual
(for Leica TCS SP2 systems)
## Table of Contents

1 Table of Contents ................................................................................................. 2

2 The Leica Confocal Software: An overview ....................................................... 7

2.1 Starting the software ...................................................................................... 7

2.2 The experimental concept of the software .................................................... 8

2.3 Basic structure of the user interface ............................................................... 8

2.4 Opening records ............................................................................................ 9

2.5 Saving images ............................................................................................... 10

2.6 Organizing data by grouping experiments .................................................... 10

2.7 Compiling experiments ............................................................................... 10

3 Starting the Operating System Windows NT™ ............................................. 11

3.1 Using a Mouse ............................................................................................... 12

3.2 The Windows NT interface .......................................................................... 12

3.3 The Start menu ............................................................................................. 13

3.4 Starting a Program ....................................................................................... 13

3.5 The Taskbar ................................................................................................ 15

3.6 Setting the Time and Date ........................................................................... 15

3.7 Getting Help ................................................................................................ 16

3.8 Shut Down Windows NT .............................................................................. 16

4 Help from the Internet ....................................................................................... 17

5 Softwarefunctions .............................................................................................. 17

5.1 Software functions for data acquisition ....................................................... 17

5.2 Softwarefunctions for data display ............................................................... 41

5.3 Software functions for measurements and analysis ..................................... 66

5.4 Softwarefunctions for documentation of data ............................................. 69

5.5 Softwarefunctions for data handling ............................................................ 73

5.6 Softwarefunctions for customization ............................................................ 77

6 Glossary ............................................................................................................ 79
1.1.1 Introduction to the Leica Confocal Software Help

Welcome to the context-sensitive online guide for Leica Confocal Software LCS.

The contents of this online help are specially customized for the accompanied product.

You have the following types of help functions at your disposal:

**Quick Help**

When you let the mouse pointer hover over a button of the Leica Confocal Software, a brief explanation of the function of this button is displayed. This so-called help banner automatically disappears when the mouse pointer is moved.

**Context-sensitive Help**

Click the Help button to start the context-sensitive help function:

![Help button](image)

This temporarily disables the functions of the user interface and a question mark appears next to the mouse pointer. Then, instead of triggering the corresponding function, clicking a button opens an explanation of the button's function. If the Help button is not present on the user interface:

- Select the Customize option in the Tools menu. A dialog window opens where you will find all buttons arranged by categories.

- The Help button is found in the File category.

- Click on it using the left mouse button and drag it to the desired window.

**Contents of the Online Help**

Select the option Contents in the Help menu to view the online help directory, which allows you to select any function in order to view information on it.

**Keyword Search (Index)**
Select the option Index in the Help menu to view an index of key words. Select a key word. View the corresponding content pages by double-clicking the key word or selecting it and then clicking the Display button.

**Full-text Boolean Search**
Select the option Search in the Help menu to launch the full-text search engine. Enter your search word in the input field. Click the triangle to the right of the input field to view the available logical operators. Select the desired operator. Enter the second search word, which you would like to associate with the first search word, behind the operator.

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>pinhole AND sections</td>
<td>This phrase finds help topics containing both the word «pinhole» and the word «sections».</td>
</tr>
<tr>
<td>pinhole OR sections</td>
<td>This phrase finds help topics containing either the word «pinhole» or the word «sections» or both.</td>
</tr>
<tr>
<td>pinhole NEAR sections</td>
<td>This phrase finds help topics containing the word «pinhole» and the word «sections» if they are located within a specific search radius. This method also looks for words that are similar in spelling to the words specified in the phrase.</td>
</tr>
<tr>
<td>pinhole NOT sections</td>
<td>This phrase finds help topics containing the word «pinhole» and not containing the word «sections».</td>
</tr>
</tbody>
</table>

**Favorites**
Select the Favorites register in the online help dialog window to store the current help topic in a list, making them easily available for future use.

**1.1.2 Opening the Context-Sensitive Help**

Select the Help button in the online help dialog window to open the context-sensitive online help function, which provides you with short explanations for the various buttons and functions of the Leica Confocal Software.

Click the Help button.
A question mark appears next to the mouse pointer. This temporarily disables the functions of all buttons.

Use the mouse pointer to click the button that you want an explanation of.

Online help opens directly to the description for the corresponding button.

Online help also provides you with an index of key words and a search function so that you can search for specific topics and buttons. Furthermore, you can print the individual descriptions.

You can also open the online help by selecting Contents, Search or Index option under the Help menu.

1.1.3 Documentation Conventions

Button
The buttons provided on the user interface of the Leica Confocal Software. Buttons are marked with icons and/or have an (often abbreviated) English label. They either trigger actions directly or open dialog windows.

Menu
The menus are divided into the categories of File, View, Macro, Tools, Window and Help and are displayed in the menu bar located at the upper edge of the user interface.

Option
Options refer to the selectable items that are hierarchically listed below the menus. Options either trigger actions directly or open dialog windows.

Dialog Window
Both buttons and options open dialog windows. Dialog windows are used to set various parameters and select functions.

Register
Registers are found in dialog windows. Registers thematically combine the parameters and functions that can be configured in dialog windows. Some registers are divided into fields.

Viewer window
The Leica Confocal Software contains two types of viewer window. The Viewer window is called up by pressing the New button and displays the recorded images. The Experiment Overview viewer window displays the recorded images in a directory tree. This viewer window is called up from the View menu and appears as a separate window at the left side of the user interface.
Legend
The Leica Confocal Software provides two legends, which display the parameters and settings of an image recording. The Experiment legend can be placed at the right edge of the Viewer window. The Hardware legend is called up from the View menu and appears as a separate window at the left side of the user interface.

Context Menu
Context menus appear when you click the right mouse button while holding the mouse pointer over certain areas of the user interface. Context menus contain various, context-sensitive commands.

see ...
This symbol is reference to another topic in the online help.

1.1.4 Acceleration keys

In order to accelerate recurring software functions, special key combinations have been defined:

<table>
<thead>
<tr>
<th>Key combination</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Opens online help.</td>
</tr>
<tr>
<td>ALT + F8</td>
<td>Opens the Macros dialog window for launching, editing, and deleting macros.</td>
</tr>
<tr>
<td>ALT + F11 (optional)</td>
<td>Launches the VBA developmental environment (optional).</td>
</tr>
<tr>
<td>CTRL + L</td>
<td>Opens the Legend Info dialog window where user-specific data can be entered to store and display them for the documentation of image recordings.</td>
</tr>
<tr>
<td>CTRL + J</td>
<td>Opens the Objective dialog window to define and select the microscopic objectives.</td>
</tr>
<tr>
<td>CTRL + N</td>
<td>Opens a new experiment.</td>
</tr>
<tr>
<td>CTRL + O</td>
<td>Launches the Open dialog window to open an existing file.</td>
</tr>
<tr>
<td>CTRL + P</td>
<td>Opens the Printer Selection dialog window.</td>
</tr>
<tr>
<td>CTRL + S</td>
<td>Stores the active experiment.</td>
</tr>
</tbody>
</table>
2 The Leica Confocal Software: An overview

2.1 Starting the software

2.1.1 Requirements for starting the software

The LCS software is copy protected to prevent it from being used on two computers at the same time. This protection system allows all additional application packages to be used. To enable the software, the provided dongle must be inserted into the parallel port of your computer. The dongle does not affect the functionality of the parallel port (e.g. for printing, etc.). To use the software on a second computer, the dongle must be fitted to its parallel port.

Note

If you remove the dongle from the confocal system control computer, the software cannot be started, preventing operation of the confocal system.

The LCS software can be started in two operating modes: hardware mode and simulation mode. In hardware mode, all hardware components are accessed and initialized by the software. For this reason, you should switch on the hardware first and then wait about 20 seconds before starting the software.

In simulation mode, the software runs independently of the hardware. This mode is intended for secondary installations on another computer, for example for training or offline analysis of existing data.

2.1.2 Starting the software

Select Start|Programs|Leica Confocal Software. The initial screen of the Leica Confocal Software appears. In this window, one of three profiles can be selected.

Company

With this option, the Leica Confocal Software is started with the default settings. In this mode, the configuration and position of toolbars is fixed and cannot be changed.

Personal

In this mode, a user-specific configuration profile can be selected. The user name depends on the account under which a person logs on to the operating system. If the user does not yet have a personal configuration profile, the default settings are used.

Last Exit

With this option, the last used configuration profile is used.

For advanced users:

If you have several configuration profiles, you can load to these at startup by clicking the button with the three small black dots at the lower right edge of the profile options. Here, you can also reset your current personal configuration profile to the default settings.
When you press the Start button, the Leica Confocal Software starts with the selected configuration profile.

Note

If you do not press the Start button, the software will start by itself after a specified time with the selected configuration profile.

2.2 The experimental concept of the software

With the Leica Confocal Software, image data or the results of image processing steps can be combined in groups. These groups are referred to as "experiments" and are stored in a specific file format (*.lei). In these experiments, original experimental image data can be stored together with image viewing data. For further details, see chapter "Organizing data by grouping experiments".

2.3 Basic structure of the user interface

The visual appearance of the Graphical User Interface (GUI) depends to a large extent on the chosen configuration profile. It does, however, contain a number of standard elements.

The following standard elements are common to all GUI configurations:

The menu bar

The menu bar contains the File, View, Macro, Tools, Window and Help menus. These menus contain commands and information for viewing data, making changes to settings and customizing the program for specific users. It does not contain functions for the direct control of scan functions. These are contained in the TCS menu (View→Menu→TCS Menu). The menu bar itself cannot be configured.

The Viewer window (TCS_Viewer)

This window displays image data, experimental conditions and user information. The image window can be configured (see chapter "Modifying the user interface and defining user-specific settings" on page 16). Beside confocal image records, the image window also shows experimental data such as system settings. An image window for a new experiment can be opened with File→New.

TCS menu (TCS_Menu)

The TCS menu contains the buttons for the individual device functions. It is arranged in individual working steps. The number of working steps varies depending on the installed software. The default set of working steps consists of data acquisition (Acquire), image viewing (View), surface reconstruction (3D), the measuring functions (Quantify), the image processing and analysis functions (Process) and the documentation functions (Annotate). If the TCS menu is not available in the current
configuration profile, you can activate it with View → Menu → TCS Menu.

The toolbars

Individual button arrangements can be set up for each individual user. A key feature of the toolbars is that they can be toggled on and off complete with all buttons. This is done with the menu option View → Menu → Container.

Viewer window for documents (Experiment Overview)

In this window, existing experiments and their content are listed in the form of a directory tree. The viewer window can be opened with View → Experiment Overview.

Status bar

The status bar appears at the lower edge of the Leica Confocal Software user interface. In it, the following information is displayed:

- The progress when loading image data (progress bar)
- The software version number
- The name of the machine configuration (system type)

For details about individual functions, see chapter "Software reference".

2.4 Opening records

2.4.1 Readable file formats

The following file formats can be opened and viewed with the Leica Confocal Software

Experiments (*.lei)

This is a Leica-specific binary file format. Files of this format contain data for complete experiments.

TIFF files (*.tif)

These are Leica image files in single and multiple tagged image file format (TIFF). Both image files in the previously used TCS formats and external files in RGB TIF format can be read.

Annotation files (*.ano)

This is also a Leica-specific binary file format. In these files, annotation sheets are stored. The elements on the annotation sheets, such as images, text and graphics, are each available as individual objects.

When a file of this type is opened, both the image data and the experiment settings are loaded.

2.4.2 Automatic reuse of instrument parameters

With the Leica Confocal Software, the hardware settings saved with experiments or single images can be carried over to a new experiment. This allows subsequent experiments to be carried out with the same settings. To carry over previous settings, open the viewer window for the record whose settings you want to reuse. Then click "Apply" (in the default configuration profile on the toolbar).
2.5 Saving images

Individual images and experiments can be saved in the file formats described in section "Readable file formats" above.

To save images and experiments, select **File → Save**. When an experiment is first saved, the "Save as" dialog opens, where you must enter a file name. You can also select a file format in this dialog. Experiments can only be saved in the Leica-specific *.lei format. When you are saving experiments, you may be able to save existing individual images in *.tif or *.raw format.

**Note**

If the experiment or image has already been saved, the previous data is overwritten each time the experiment or image is saved. To prevent this, you must save the data under a new filename with **File → Save as**.

2.6 Organizing data by grouping experiments

The Leica Confocal Software allows single images, image series, and the results of image processing steps to be combined in a group (an experiment). The experiment overview window provides an overview of all loaded experiments. If the experiment overview window is not visible, you can open it with **View → Experiment Overview**. With **File → New** and **File → New(Template)** a new experiment can be created. In the same way, existing files that are being opened are managed as separate experiments.

2.7 Compiling experiments

After you have created a new experiment with **File → New** or **File → New(Template)**, you can assign data to it.

**Note**

Images acquired with the continuous scan function are automatically overwritten the next time a scan is started. If you want to permanently keep a single image as part of an experiment, choose the single scan function.
An experiment contains data acquired with the single or series scan function. If you perform image processing functions on a record, you can also save the results as part of the experiment. To do this, double-click the desired image or series in the experiment overview. Now carry out the image processing functions (e.g. maximum projection or topology image). Mark the area within the Viewer window that you want to add to the experiment. With the right mouse button (context menu), select *Send to Experiment.* The *Selection (raw)* option creates a copy of the raw data for the selected object as a new, separate component of the experiment. The *Selection (snapshot)* option creates an RGB image (no 3D data, photo only) of the selected object as a new component of the experiment.

3 Starting the Operating System

**Windows NT™**

You don't have to start Windows NT ™-- it starts automatically when you turn on your PC. You will first see a splash screen. Next you have to log on to your computer. As you can see from the instructions in the box, pressing the Ctrl, Alt and Delete keys at the same time will log you on.

Once you press the Ctrl, Alt, and Delete keys, the Logon Information dialog box is displayed.

Typing your password identifies you as a valid user for this computer.

The default User name for the Leica TCS SP II system is "". Default password is "". After being logged in you can change your password by pressing Ctrl, Alt and Delete keys at the same time.

Then click on change password. The Change Password dialog box displays.

Type your current password in the Old Password field (passwords are case sensitive, so be sure you use the right case), then press the Tab key. Pressing the Tab key moves the cursor to the next field.

Type your new password, then press the Tab key again. Retyping the new password confirms that you aren't making a typing error. This is important since the characters you type appear as asterisks on the screen.

**Note**

*If you miss-type the confirmation password, you will see a warning dialog. Try again!*

Then click the OK button. Your new password will be in effect the next time you log on.

**Caution**

*Do not forget your password if you set one! Without the right password you can't access your computer anymore.*
The Welcome dialog box is now displayed. Take a moment to read the „Did you know...“ tip and then click the Close button to begin using Windows NT.

### 3.1 Using a Mouse

You need a mouse to work most efficiently in Windows NT. Here are the mouse actions you need to know:

**Point** means to move the mouse pointer onto the specified item by moving the mouse. The tip of the mouse pointer must touch the item.

**Click on an item** means to move the pointer onto the specified item and press and release the mouse button once. Unless specified otherwise (i.e. right-click), use the left mouse button. Clicking usually selects an item.

**Double-click on an item** means to move the pointer to the specified item and press and release the left mouse button twice quickly. Double-clicking usually activates an item.

**Drag** means to move the mouse pointer onto the item, hold down the mouse button, and move the mouse while holding down the button. Unless specified (i.e. right-drag), use the left mouse button.

### 3.2 The Windows NT interface

The basic interface of Windows NT is called the „Desktop“, which provides a background for the items it contains.

The initial icons on the Desktop allow the user to view and interact with the system in a logical way.

The Windows NT screen contains many special elements and controls. Here’s a brief summary:

The background on which all the pictures and boxes rest is the desktop.

The Taskbar shows the windows and programs that are open. You can switch between open windows and programs by clicking the name on the Taskbar.

The Start button opens a menu system from which you can start programs. Click on the Start button; then, click on your selection from each menu that appears.

Some icons appear on your desktop. You can activate one by double clicking on it.

We now take a brief tour of the items you see on the screen.

A standard desktop item is the My Computer icon. Double-clicking this icon opens the My Computer window.

The ‘My Computer’ window gives you easy access to the major components like hard and floppy disk drives of your computer system or workstation. For example, by double-clicking the Hard disk [C:] icon you can see the contents of your PC’s hard drive. This allows the user to view local resources as objects. Access to the Windows NT Workstation 4 control panel and print support/control are also accessible from ‘My Computer’. If at installation time you installed one of the additional local applications such as ‘Dial-Up Networking’ this will also appear within ‘My Computer’.
You can use the **Control Panel** icon in the My Computer window to view and change any system component. The Control Panel contains numerous icons that allow you to control your system. The particular icons that you see on your PC may be slightly different from those illustrated, due to that fact that you may have different hardware installed, and may or may not be connected to a network or modem. You may also have different Windows NT Workstation 4 options installed.

Double-clicking the **Network Neighborhood** icon displays the Network Neighborhood dialog box which gives you information about who and what is connected to your workstation. It provides an easy mechanism for browsing any network systems and resources that you may be able to connect to in a way that is independent of the actual type of network vendor. Traditionally, if a system needed to be simultaneously connected to different types of network, the way in which each could be connected and viewed would be vendor specific. Windows NT Workstation 4 is capable of displaying a common view of your entire network even though it may actually comprise resources from Windows NT, Novell NetWare, Banyan Vines, or others!

The **Inbox** icon is used if Microsoft Exchange is active on your system. Windows NT Workstation 4 has in-built electronic mail services based on Microsoft Mail (MS Mail) and Microsoft Exchange. If there is already an MS Mail post office on the same network that the system is connected to, the Windows NT Workstation 4 mail client can connect directly into it. The Inbox lets you access your messages.

The **Recycle Bin** icon represents the holding place for deleted items. As long as files are in the Recycle Bin they can easily be recovered if they have been accidentally deleted. Windows NT Workstation 4 will preserve files until the system runs out of free disk space. When this happens Windows NT Workstation 4 will prune the contents of the Recycle Bin on a first-in first-out basis.

---

**Caution**

*Files that are overwritten due to an application using a duplicate filename will not be saved to the recycle bin.*

Double-clicking the Bin displays its contents. The empty window confirms that there are no items in the Recycle Bin.

### 3.3 The Start menu

A single click of the left-hand mouse button on the Start button will invoke the start menu and present you with the seven major categorized options for starting work on the system.

A single click of the right-hand mouse button will invoke a small but powerful control menu containing the options Open, Explore and Find.

Their functionality is described as follows:

#### 3.4 Starting a Program

The Start menu contains the various categories where your applications and work are stored. You can move further into the various subcategories by positioning the mouse over the category that you are interested in to automatically open the next subcategory. You do not have to click the mouse!
The **Programs** command displays the Programs menu. This menu lists all of the applications installed and available to you. An arrow, meaning that there is a submenu follows some items. Drag the mouse cursor over the **Accessories** command to see its submenu. The Accessories submenu lists the set of Windows NT built-in programs.

**TIP:** If you drag an object either from the Desktop or from the Windows Explorer and drop it directly onto the Start button a link to that object will automatically appear in the Start menu.

There are many ways to start a program. The simplest is here:

- Click the Start button.
- Click Programs.
- Click on the group that contains the program you want to start (for instance, LCS).
- Click on the program you want to start (for instance, Leica LCS).

Another way to start a program is to open a document that you created in that program. The program automatically opens when the document opens. Double-click on a document file in My Computer or Windows Explorer to open it, or click the Start button and select a recently used document from the Documents menu.

You can also start a program by double clicking on its shortcut icon on the desktop. Shortcut icons are links to other files. When you use a shortcut, Windows simply follows the link back to the original file.

Whenever you use a document or program frequently, you might consider creating a shortcut for it on the desktop. To do so, just use the right mouse button to drag an object out of Windows Explorer or My Computer. On the menu that appears, select Create Shortcut(s) Here. Some programs automatically create a shortcut during their installation procedure.

---

**Caution**

*Windows NT Workstation 4 does not actively track a link between an original and a shortcut. For instance, if you create a shortcut of a program, and subsequently move (rather than copy) the original to a different folder, then the shortcut may no longer function.*

The Startup folder is special in one respect, any programs held within it will start automatically when you start Windows NT Workstation 4.

The Documents menu shows the names of the 15 files you created most recently. You can open any of these files and its related application at the same time by clicking the file’s name in this menu.

---

**Caution**

*Document files that are opened within an application (typically by selecting the File/Open command within the application) will not be displayed here. Only documents opened directly from the Desktop will be displayed here.*
The Settings menu offers three commands for changing your system's settings. You can directly access the Control Panel and Printing folders. Also accessible is the Task Properties window.

Being able to access the core system configuration utilities in this way is particularly useful when an application is already in the foreground and you want to make a quick change.

The Find command features an easy way to locate all system resources. Within the Find category you can perform searches for three distinct types of search which are described as follows:

### 3.5 The Taskbar

The Taskbar – positioned at the bottom of the screen – provides a constant view of which applications are running on the system and an easy way to switch between them. As you add to the number of concurrently running applications the Taskbar automatically re-sizes its iconized view of the applications to ensure that they can always be seen. To switch from one running program to another, simply click on the second program as displayed in the Taskbar.

The Taskbar also provides constant additional information such as the system time and volume control if you have a sound card fitted, all of which can be further tailored by the user.

### 3.6 Setting the Time and Date

The current Date, Time and Time Zone information can be set from the Date/Time icon within the Control Panel. This setting is important since Windows NT stamps the date and time on all of your files as you create and modify them. The two options can be selected by clicking on the appropriate tab.

**To change the Date and Time**

Click on the appropriate date or use the controls to change the month or year. The time can also be changed by first selecting the digital display and then using the up and down arrows.

**To change the Time Zone**

Select the appropriate Time Zone from the drop down list at the top of the screen. Notice that the option to automatically adjust the clock for daylight savings time is selected. On some systems you can also drag the highlighted area on the world map and drop it on the correct location.

Changing the date and time information within Windows NT Workstation 4 will update the battery backup CMOS clock in your system.

**Note**

*Depending on the shell configuration, systems connected to a network may get a time and date update from a network server every time they log on. If the servers time is incorrect your workstations time will be wrong too. Please inform your network manager.*
3.7 Getting Help

Windows NT includes a powerful help system. In addition to Help menus in every window, there is a standalone Help feature available from the Start menu. To access it, click your mouse on the Start button, and click on Help.

There are three tabs in this box: Contents, Index, and Find. The Contents tab appears on top first. To move to a tab, click on it.

Contents

The Contents tab displays individual Help topics. The topics are organized into categories and are represented by small book icons. Double-click on any book to open it. Sub-books and documents appear. Double-click on sub-books and documents to open them.

Index

The Index tab displays an index of all available topics. Type the word you want to look up. The Index list scrolls to that part of the alphabetical listing. When you see the topic on the list that you want to read, double-click on it.

Find

The Find tab provides a text entry box for you to type the specific word(s) or phrase you want to search for under Help, rather than searching for information by category. The text entry box is linked to a list of words in your Help files and any words or phrases that match will be shown. You can specify more than one word by separating words with a space. If you wish to change a search option, select Options. The first time you click on this tab, Windows tells you it needs to create a list. Click Next, and Finish to allow this. Then you see the main Find tab. Type the word(s) you want to find in the top text box. Then click a word in the middle box to narrow the search. Finally, review the list of help topics at the bottom, and double-click the one you want to read.

When you’re done reading about a document, click Help Topics to return to the main Help screen, or click Back to return to the previous Help topic. Click the window’s Close button to exit Help.

3.8 Shut Down Windows NT

Always use the Shut Down command before you turn off your PC. The Shut Down option allows the user to close the Windows NT Workstation operating system and ensure all running processes can halt cleanly and are given the chance to flush any data that may be in cache memory out to the disk. Several options are available when shutting the system down.

Caution

*Powering down your computer without prior shutting it down may result in severe data loss.*
4 Help from the Internet

First contact your local Leica subsidiary or the local dealer. You can also find information on Leica Microsystems Heidelberg GmbH and confocal microscopy on our web site http://www.llt.de. Send email to support@llt.de.

5 Softwarefunctions

5.1 Software functions for data acquisition

5.1.1 Selecting an Objective

Function

Click the Objective button to open a list of objectives and select an appropriate one for recording your images. This list shows only the objectives that have been assigned to the up to seven slots on the revolving nosepiece. You can assign objectives as follows:

- Select the Objective option from the Tools menu. A dialog window opens containing an extensive list of objectives and the symbolic representation of the slots on the revolving nosepiece.

- Find in the list the objective that you are using and select it with the mouse. Click and hold the left mouse button and drag the objective onto the symbol representing the slot in which the objective is installed.

- The assignment is saved in the software and the objective appears in the selection list, which you can open by pressing the Objective button.

- Repeat this procedure for every objective that you have installed in the revolving nosepiece.

You can use the Add, Remove and Edit buttons in this dialog window to add new objectives, remove objectives or edit existing objective entries.
Note

The revolving nosepiece of DM RXA, DM RXE and DM IRBE microscopes is triggered by the software so that the objective is moved automatically into the beam path when you select an objective with the Objective button or dialog window. With all other microscope types the objective has not only to be assigned in the software but also be moved manually into the beam path.

Additional Information

When selecting the correct objective for a specific application, the objective’s correction class (achromats, apochromats, fluorite objectives and plan-objectives) and especially the magnification factor and the numerical aperture are of great significance. The numerical aperture determines the resolution capacity of an objective and is deduced from the angle of the light cone accepted by the objective lens and the refractive index of the medium between objective lens and specimen: \( NA = n \times \sin \alpha \)

Objectives with greater magnification generally have larger numerical apertures but smaller entrance pupils and therefore can record light only from a relatively small scan field. Objectives with larger apertures permit higher resolutions but allow less free working distance. The following table illustrates this relationship:

<table>
<thead>
<tr>
<th>Objective</th>
<th>Resolution (xy)</th>
<th>Resolution Air (z)</th>
<th>Resolution Water (z)</th>
<th>Resolution Oil (z)</th>
<th>Scan Field Size (xy)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HC PL FLUOTAR 5x 0.15</td>
<td>1301</td>
<td>19410</td>
<td>25879</td>
<td>29559</td>
<td>3000</td>
</tr>
<tr>
<td>HC PL FLUOTAR 10x 0.30</td>
<td>651</td>
<td>4768</td>
<td>6407</td>
<td>7335</td>
<td>1500</td>
</tr>
<tr>
<td>N PLAN 20x 0.40</td>
<td>488</td>
<td>2630</td>
<td>3566</td>
<td>4093</td>
<td>750</td>
</tr>
<tr>
<td>N PLAN 50x 0.75</td>
<td>260</td>
<td>649</td>
<td>948</td>
<td>1108</td>
<td>300</td>
</tr>
<tr>
<td>PL APO 100x 1.40</td>
<td>139</td>
<td>319</td>
<td>209</td>
<td>236</td>
<td>150</td>
</tr>
</tbody>
</table>

Values in nm at wavelength \( \lambda = 488 \text{ nm} \)

Values in \( \mu \text{m} \)

Typical Applications

Dry objectives are typically used in materials science for the examination of surface structures. When imaging layered structures in which the material layers have different refractive indices, immersion objectives are most suitable. With biological specimens it depends on the specimen and the medium in which it is embedded whether an oil-immersion objective or a water-immersion objective should be applied. The highest resolution is achieved, when the refractive indices of the immersion medium or the specimen on the one hand and the objective medium on the other are as homogeneous as possible.
5.1.2 The Electronic Zoom

**Function**
In confocal microscopy, the magnification of an image is determined both by the objective and the electronic zoom. The objective generates an intermediate image magnified based on the objective's magnification factor. Additional magnification is provided by the electronic zoom. At a zoom factor of 1 the maximum scan field size is scanned with a specified number of sampling points. If the zoom factor is set to 2, the same number of points is used to scan a scan field with only half the length of a side of the maximum scan field (1/4 the original scan field). This achieves stronger magnification and thus better image resolution, because a smaller scan field is scanned with the same frequency, which results in a higher density of data.

You can select one of the preset zoom factors in the dialog window that is opened with the Zoom button. If you click Others, there are two ways of specifying another zoom factor:

- Use the mouse to move the slide on the scale. The corresponding value is shown in the middle of the dialog window.
- Double-click the boldface numerical value located in the middle of the dialog window. This opens a second dialog window where you can enter an exact value.

You can also set the zoom factor using the corresponding rotary knob of the control panel.

[see Controlling Functions from the Control Panel](#)

**Additional Information**
While zoom factors from 1 to 36 can be set, the useful magnification of the electronic zoom cannot be increased infinitely. The limit is achieved with the smallest optically resolvable distance, which is determined by the resolution capacity of the objective. According to the Nyquist theorem the smallest optically resolvable distance can be mapped without loss of information if it is scanned with about 2 to 3 raster points. If this scan frequency is exceeded with a relatively high zoom factor and a selected scan format, further magnification is no longer useful because no more optical details can be resolved (empty magnification).

[see Selecting a Scan Format](#)
[see Selecting an Objective](#)
**Note**

With bleach-sensitive specimens it is advisable to restrict the use of the electronic zoom to short time intervals. At high zoom factors a section of the specimen is recorded with a relatively higher scan frequency, and thus exposed to a high illumination intensity. This can destroy the specimen photochemically (optical bleaching), making it unfit.

**Optimal Zoom Factors**

The following table shows which zoom factors (marked red) - at a given scan format and scan field size defined by the objective - can be used to scan the specimen without loss of data:

<table>
<thead>
<tr>
<th>Objective</th>
<th>Scan Format</th>
<th>Scan Field Size (µm)</th>
<th>Scan Frequency (nm)</th>
<th>Resolution/Scan Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magnification</td>
<td>Numerical Aperture</td>
<td>Resolution at λ 488 nm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>0,6</td>
<td>325</td>
<td>1024 x 1024</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>512 x 512</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>200 x 200</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>16</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>40</td>
<td>1,25</td>
<td>156</td>
<td>1024 x 1024</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>512 x 512</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>200 x 200</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>16</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>100</td>
<td>1,4</td>
<td>139</td>
<td>1024 x 1024</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>512 x 512</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>200 x 200</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>8</td>
</tr>
</tbody>
</table>
Note

The Leica Confocal Software provides three different zoom features: the electronic zoom, the 3D zoom and the graphical zoom.

See Zooming the 3D View
See The Viewer Options Dialog Window, Display Icon

5.1.3 Setting the Detection Pinhole

Function

Clicking the Pinhole button opens a dialog window that you can use to set the diameter of the detection pinhole. In the upper right list field in the dialog window, select the units for displaying the diameter. You can select from µm, Airy units and digital values. There are two ways of specifying a value for the diameter:

- Use the mouse to move the slide on the scale that is displayed on the left in the dialog window. The corresponding value is shown in the middle of the dialog window.
- Double-click the boldface numerical value located in the middle of the dialog window. This opens a second dialog window where you can enter an exact value.

The diameter of the detection pinhole must be set to the currently used objective at all times. If you click the Airy 1 button, the detection pinhole is set automatically to the optimal value of 1 Airy unit depending on the objective in use.

In addition to the numerical aperture of the objective and the wavelength of the light, the detection pinhole also determines the thickness of the optical sections.

Additional Information

The diameter of the pinhole is set optimally if it matches the diameter of the Airy disc. The Airy disc refers to the inner, light circle of the diffraction pattern of a point light source. The diameter of the Airy disc, in turn, is also dependent on several optical parameters and can be described for the Leica Confocal System as follows:

$$d_{\text{Airy}} = \frac{1.22 \cdot \lambda}{\text{NA}} \cdot M \cdot 3.6$$
To calculate the diameter of the Airy disc, you need the excitation wavelength $\lambda$ (if working with several wavelengths, a mean value should be applied), the numerical aperture (NA) and the magnifying factor (M) of the objective. The factor of 3.6 refers to the magnification of other optical components belonging to the Leica Confocal microscope.

If the pinhole is set to the Airy disc, light from outside the focal plane is suppressed and the signal-to-noise ratio will be high. These conditions allow the recording of optical sections of minimum thickness. The wider the diameter of the pinhole, the more light reaches the detector. The image becomes brighter but also increasingly blurred because structures outside the focus also appear in the image.

Increasing the diameter of the pinhole above 1 Airy unit is recommended only for detecting very weak signals.

Generally when recording material scientific specimens, enough light is reflected into the detectors so that the detection pinhole can be closed completely (i.e. set to the minimum diameter).

5.1.4 Selecting a Scan Format

Function
Clicking the Format button opens a dialog window that contains a selection of various scan formats. Selecting the scan format selects the image raster that will be used for recording the images. The image raster refers to the number of points in the three spatial directions that are to be scanned from the specimen. Besides the numerical aperture of the objective and the excitation wavelength, the scan format, together with the electronic zoom, determines in large part the spatial resolution of the recorded data.

Additional Information
When selecting the scan format, observe the influences between the image raster and the resolution of the generated image. According to the Nyquist theorem (or sampling theorem), a structure can only be scanned without information loss if the smallest optically resolvable distance is scanned with about 2 to 3 raster points. This optically resolvable distance, called lateral resolution, depends on the numerical aperture of the objective and the wavelength of the applied excitation light:

$$\text{lateral resolution} = \frac{0.4 \cdot \lambda}{\text{NA}}$$
The following example should illustrate this relationship: You have selected, for example, the PL APO 100x objective unit with a numerical aperture of \( NA = 1.4 \) and a wavelength of \( \lambda = 488 \) nm. Based on these factors, the smallest optically resolvable distance is determined as follows:

\[
\frac{0.4 \cdot 488 \text{ nm}}{1.4} = \text{ca.} 140 \text{ nm}
\]

Based on this rough formula, the distance of the raster points required to avoid information loss while recording is:

\[
\frac{140 \text{ nm}}{3} = \text{ca.} 47 \text{ nm}
\]

If however you select a scan format of 1024x1024, a PL APO 100x objective, which has a maximum scan field size of 150 \( \mu \)m, would result in the following raster point distance:

\[
\frac{150 \mu \text{m}}{1024} = \text{ca.} 146 \text{ nm}
\]

To achieve the necessary raster distance of 47 nm, you now have the option of increasing the scan format (for example to 2048x2048) or decreasing the scan field size using the electronic zoom (zoom=2).

The current raster distance is displayed in the hardware legend. In the legend the value is referred to as Voxel Size and is calculated as soon as you change the scan format, the electronic zoom or the objective.

See [The Electronic Zoom](#)  
See [Selecting an Objective](#)

**Note**

When the sampling rate of 2 to 3 points is exceeded, it is referred to as oversampling. In the case of oversampling, the structure is fully mapped but no additional information is gained. The disadvantage of oversampling is the long scanning time and the danger of destroying bleach-sensitive specimens. When the sampling rate is less than 2 to 3 points, it is referred to as undersampling. In this case, there is the danger that not all necessary information is sampled. The image might illustrate structures that are not actually present in the specimen. This effect is called **aliasing**.

---

Page 23
5.1.5 Selecting a Scan Mode

Function
Clicking the Mode button opens a dialog window containing a list of available scan modes. The scan mode determines which optical levels of the specimen are to be scanned. Fundamentally, horizontal xy-sections or vertical xz-sections can be recorded. To generate a three-dimensional image of the specimen, the optical sections are continued in the corresponding third direction in space, thus recording a stack of individual images. In addition to this, it is possible to add the factor of time or wavelength while recording the images:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>xyz</td>
<td>An image stack is recorded from xy-sections in z-direction.</td>
</tr>
<tr>
<td>xzy</td>
<td>An image stack is recorded from xz-sections in y-direction.</td>
</tr>
<tr>
<td>xt</td>
<td>A line is recorded several successive times.</td>
</tr>
<tr>
<td>xyt</td>
<td>An xy-section is recorded several successive times.</td>
</tr>
<tr>
<td>xzt</td>
<td>An xz-section is recorded several successive times.</td>
</tr>
<tr>
<td>xytz</td>
<td>An image stack is recorded from xy-sections in z-direction several successive times.</td>
</tr>
<tr>
<td>xy\lambda</td>
<td>An xy-section is recorded at different wavelengths.</td>
</tr>
<tr>
<td>xz\lambda</td>
<td>An xz-section is recorded at different wavelengths.</td>
</tr>
</tbody>
</table>

All scan modes (with the exception of xt) are composed of at least three dimensions. The unit will ignore the third and further dimensions if you record using the continuous scan function or the single scan function from one optical level only (xy or xz).

Note

*The scan modes xzy, xzt and xz\lambda are only displayed in the list, if you have previously selected the Galvo item using the Z-Scan button. Likewise, the scan modes for a wavelength series xy\lambda and xz\lambda are only displayed, if only one detector is activated in the Beam Path Setting dialog window.*

[see Selecting the Z-Actuator]
[see Setting the Beam Path]
5.1.6 Selecting a Scan Speed

Function
Clicking the Speed button opens a dialog window that you can use to select from four different scan speeds:

<table>
<thead>
<tr>
<th>Speed</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>Image lines per second</td>
</tr>
<tr>
<td>400</td>
<td>Image lines per second</td>
</tr>
<tr>
<td>800</td>
<td>Image lines per second</td>
</tr>
<tr>
<td>1000</td>
<td>Image lines per second</td>
</tr>
</tbody>
</table>

The data recording speed can be further increased in combination with the bidirectional scan.

See Unidirectional or Bidirectional Scan

Additional Information
The faster the scan speed is, the shorter the dwell time of the laser point. The scan format, i.e. the number of sampling points on a line, must also be taken into consideration. The higher the scan format at a constant speed is, the shorter the dwell time of the laser point over a sampling point.

The longer the light point of the laser beam dwells over the individual sampling points of the specimen, the more light is detected by the detector. So using a lower scan speed results in a better signal-to-noise ratio. The disadvantage of a lower scan speed is that the relatively long impact of the light on the specimen can bleach the specimen photochemically, making it unusable. This is especially important with fluorescence applications.

Note
If the speed is set to 800 or 1000, the maximum scan field can no longer be scanned because of technical, device-related reasons. The system switches automatically to zoom factor 2 and zoom factor 4 respectively.
5.1.7 Setting the Z/Y-Position

**Function**

Use the z/y-Position button to define the horizontal level (z-position) or vertical level (y-position) of the specimen in which the images are to be recorded. If you want to record an image series using the Series Scan function, you use the z/y-Position button and the Begin and End buttons to define the begin and end points of the image series.

See [The Series Scan Overview Dialog Window](#).

Clicking the z/y-Position button opens a dialog window that provides you with two ways of specifying a position value:

- Use the mouse to move the slide on the scale that is displayed on the left in the dialog window. The corresponding position value is shown in the middle of the dialog window.
- Double-click the boldface position value located in the middle of the dialog window. This opens a second dialog window where you can enter an exact value.

You can also set the z/y-position using the corresponding rotary knob of the control panel.

See [Controlling Functions from the Control Panel](#).

5.1.8 Configuring a Time Series

**Function**

Click the Time button to open the Time Configuration dialog window for setting up a time series recording. The parameters you can set in this dialog window depend on the selected scan mode. You can record a line (xt), a horizontal section (xyt), a vertical section (xzt) or a stack of horizontal sections (xyzt) many successive times interrupted by a certain time interval.

**Note**

The Time button is not enabled unless you have selected a scan.
mode with time dimension using the Mode button.

> see Selecting a Scan Mode

With a time series using the xt scan mode the following parameters are displayed in the dialog window:

<table>
<thead>
<tr>
<th>ΔT</th>
<th>Recording time for a line (cannot be adjusted by the user)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lines</td>
<td>Number of recordings of the line</td>
</tr>
<tr>
<td>Lines per page</td>
<td>Number of lines per virtual memory page</td>
</tr>
<tr>
<td>Pages</td>
<td>Number of virtual memory pages (is calculated automatically)</td>
</tr>
<tr>
<td>Complete Time</td>
<td>Complete recording time, i.e. product of ΔT and number of recordings</td>
</tr>
</tbody>
</table>

Use the Calculate button to calculate how many virtual memory pages result from a given number of lines per page.

With a time series using the xyt or xzt scan mode the following parameters are displayed in the dialog window:

<table>
<thead>
<tr>
<th>ΔT</th>
<th>Recording time for one xy-section or xz-section plus pause interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frames</td>
<td>Number of recordings of the xy-section or xz-section</td>
</tr>
<tr>
<td>Complete Time</td>
<td>Complete recording time, i.e. product of ΔT and number of recordings</td>
</tr>
</tbody>
</table>

With a time series using the xyzt scan mode the following parameters are displayed in the dialog window:

<table>
<thead>
<tr>
<th>ΔT</th>
<th>Recording time for one image stack of xy-sections plus pause interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stacks</td>
<td>Number of recordings of the image stack</td>
</tr>
<tr>
<td>Complete Time</td>
<td>Complete recording time, i.e. product of ΔT and number of recordings</td>
</tr>
</tbody>
</table>

Each parameter can be calculated as a function of the other parameters. When entering the values observe the special operating principle of the dialog window. Clicking an entry field deactivates it:

Click the parameter that is to be calculated. The corresponding entry field appears grey.
Now enter the values for the other parameters.

Click Apply to calculate the parameter. Clicking Reset displays the last saved values.

When you have finished configuring these settings, press the Series Scan button.

### 5.1.9 Starting a Single Scan

**Function**

Use the Single Scan button to record a single image from a single optical level in the specimen.

Before recording an image using the single scan function, configure all required scan parameters using the Continuous Scan function to ensure optimal image quality.

📖 see Starting a Continuous Scan

**Typical Applications**

The single scan function is designed for recording bleach-sensitive specimens. Use this function in the case of bleach-sensitive specimens not only for image recording, but also as an alternative to the continuous scan function for setting the scan parameters. The single scan function can also be used to check the image section by zooming in on the scan field.

### 5.1.10 Starting a Continuous Scan

**Function**

Use the Continuous Scan button to permanently record images from a single optical level in the specimen. This does not generate image series, since the image being generated always replaces the previously generated image.
Press the button a second time to stop the continuous scan.

**Additional Information**

The unit applies the last used scan parameters automatically. You can modify some of the parameters *while* the image is being recorded. Others have to be configured *before* you start the recording:

<table>
<thead>
<tr>
<th>Before Recording</th>
<th>While Recording</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selecting the objective</td>
<td>Setting the beam path</td>
</tr>
<tr>
<td>Selecting the scan format</td>
<td>Setting the detection pinhole</td>
</tr>
<tr>
<td>Selecting the scan mode</td>
<td>Setting the electronic zoom</td>
</tr>
<tr>
<td>Selecting the scan speed</td>
<td>Setting the detectors</td>
</tr>
<tr>
<td>Selecting unidirectional or bidirectional scan</td>
<td>Adjusting the phase</td>
</tr>
<tr>
<td></td>
<td>Setting the z/y-position</td>
</tr>
</tbody>
</table>

The buttons of the functions that cannot be changed during continuous scanning are disabled and appear gray.

**Typical Applications**

The continuous scan function is best used to optimize the image quality for the first scan of a specimen. While the specimen is being scanned continuously, you can modify the scan parameters listed above and check the results directly in the image.

**Note**

With bleach-sensitive specimens it is advisable to restrict the use of the Continuous Scan function to short time intervals. Subjecting the specimen to the continuous light of the laser can destroy the specimen photochemically (*optical bleaching*), making it unfit.

**5.1.11 The Series Scan Overview Dialog Window**

**Function**

This dialog window lets you define the begin and end points of an image series and trace the recording of the individual sections. The three-dimensional scan area is represented graphically as a cube. Within this cube, a yellow square represents the current z-position and y-position, a green one represents the begin point and a red one the end point. The
corresponding position values are displayed to the right of the cube. Set the begin and end point as follows.

- Use the mouse pointer to drag the yellow square to the level in which the image series is to begin. Or click the z/y-Position button to open a dialog window where you can enter the values of the z-position and y-position.

- Click in the white box for the begin point. The corresponding position value appears and is saved.

- Use the mouse pointer to drag the yellow square to the level in which the image series is to end. Or click the z/y-Position button to open a dialog window where you can enter the values of the z-position and y-position.

- Click in the white box for the end point. The corresponding position value appears and is saved.

- The entire height of the image stack between the begin and end points is calculated and displayed (Total).

Now click the Series Scan button. The dialog window stays open and you can follow the process of the image series being recorded.

**Note**

You can also define the begin and end points using the control panel and the separate Begin and End buttons.

See Defining the Begin Point for a Spatial Series
See Defining the End Point for a Spatial Series
See Setting the z/y-Position

**Additional Information**

The following additional parameters, which have to be set before recording an image series, are specified in the Series Scan Overview dialog window:

- Scan mode (top line to the right of the graphic image)
- Scan format (red digits at the upper edge of the cube)
- Number of optical sections (division between begin and end points)

The red number on the vertical edge of the cube represents the maximum travel of the z-actuator that cannot be changed.

See Selecting a Scan Mode
See Selecting a Scan Format
See Defining the Number of Spatial Sections
5.1.12 Defining the Begin Point for a Spatial Series

Function
Use the Begin button to define the begin point of a spatial image series. First set the exact z-position or y-position using the z/y-Position button or on the control panel using the corresponding rotary knob. Then click Begin. This saves the position value for the begin point. The end point is set in the same manner.

Note
You can also set the begin and end points for a spatial series in the Series Scan Overview dialog window. Open this dialog window by pressing the Series button (the small button, not the button that starts the Series Scan function).

5.1.13 Defining the Begin Point for a Wavelength Series

Function
For a wavelength series, this function records a stack of individual images, each of which are detected at a specific wavelength, from a single, optical level. Use the Lambda Scan Begin button to define the wavelength at which recording should begin.

Note
The Lambda Scan Begin button is not enabled unless you have selected a scan mode with wavelength dimension using the
Press Beam to open the Beam Path Setting dialog window.

Activate a detector by clicking its corresponding check box. A cast shadow now links the activated detector to the corresponding slide bar on the scale of the spectrum.

Double-click this slide bar to open the Range Properties dialog window, where you can specify the detection bandwidth.

Drag the slide bar on the scale of the spectrum to the desired begin point. The left edge of the slide bar represents the wavelength at which the recording is to begin.

Click Lambda Scan Begin to save the value.

The end point of a wavelength series is set in the same manner. In addition, you also have to set the number of wavelength steps.

Typical Applications
A wavelength series can be applied to determine the maximum emission of a fluorochrome. This is useful because the Stokes shift of the emission curve of a fluorochrome is dependent on each specimen that is applied. This then allows you to set the detection range precisely for a specific application.

5.1.14 Defining the End Point for a Spatial Series

Function
Use the End button to define the end point of a spatial image series. First set the exact z-position or y-position using the z/y-Position button or on the control panel using the corresponding rotary knob. Then click End. This saves the position value for the end point. The begin point is set in the same manner.
Note

You can also define the begin and end points for a spatial series in the Series Scan Overview dialog window. Open this dialog window by pressing the Series button (the small button, not the button that starts the Series Scan function).

see The Series Scan Overview Dialog Window

5.1.15 Defining the End Point for a Wavelength Series

Function

For a wavelength series, this function records a stack of individual images, each of which are detected at a specific wavelength, from a single, optical level. Use the Lambda Scan End button to define the wavelength at which recording should end:

Note

The Lambda Scan End button is not enabled unless you have selected a scan mode with wavelength dimension using the Mode button.

see Selecting a Scan Mode

- Press Beam to open the Beam Path Setting dialog window.
- Activate a detector by clicking its corresponding check box. A cast shadow now links the activated detector to the corresponding slide bar on the scale of the spectrum.
- Double-click this slide bar to open the Range Properties dialog window, where you can specify the detection bandwidth.
- Drag the slide bar on the scale of the spectrum to the desired end point. The right edge of the slide bar represents the wavelength at which the recording is to end.
- Click Lambda Scan End to save the value.
The begin point of a wavelength series is set in the same manner. In addition, you also have to set the number of wavelength steps.

- see Defining the Begin Point for a Wavelength Series
- see Setting the Number of Wavelength Steps

**Typical Applications**
A wavelength series can be applied to determine the maximum emission of a fluorochrome. This is useful because the Stokes shift of the emission curve of a fluorochrome is dependent on each specimen that is applied. This then allows you to set the detection range precisely for a specific application.

### 5.1.16 Defining the Number of Spatial Sections

**Function**
Clicking the Sections button opens a dialog window that you can use to select the number of horizontal xy-sections and vertical xz-sections for recording a picture series. If you want to specify a number of sections that is not listed, click the Others option. This opens the Z/Y Configuration dialog window, which contains the following data:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Dim. z (µm)</td>
<td>The height of the entire image stack between the begin and end points of the image series</td>
</tr>
<tr>
<td># Sections</td>
<td>The number of configured sections</td>
</tr>
<tr>
<td>Step Size (µm)</td>
<td>The distance between two sections</td>
</tr>
</tbody>
</table>

Enter any desired value for the number of sections and the step size in this dialog window. The value for the height of the image stack cannot be altered, since this parameter is determined by the begin and end points of the image series. The step size has always to be a multiple of the minimum step size of the z-actuator, so that certain combinations of values are only possible if either the height of the image stack or the number of sections is changed. Depending on which of the both Calculate buttons you click, one of the two parameters is kept unchanged.

Calculating the number of sections with the priority for keeping the height of the image stack unchanged:
Enter the desired step size in the Step Size field. Then click the Calculate button next to the Step Size field.

Calculating the number of sections with the priority for keeping the number of sections unchanged:

Enter the desired step size in the Step Size field. Then click the Calculate button next to the # Sections field.

Calculating the step size with the priority for keeping the height of the image stack unchanged:

Enter the number of desired sections (whole numbers only) in the # Sections field. Then click the Calculate button next to # Sections field.

Calculating the step size with the priority for keeping the number of sections unchanged:

Enter the number of desired sections (whole numbers only) in the # Sections field. Then click the Calculate button next to the Step Size field.

Clicking Reset displays the last saved values.

see Starting a Series Scan
see The Series Scan Overview Dialog
see Selecting the Z-Actuator

5.1.17 Setting the Number of Wavelength Steps

Function
For a wavelength series, this function records a stack of individual images, each of which are detected at a specific wavelength, from a single, optical level. The images are recorded within a wavelength range, which is limited by the begin and end points. Use the Lambda Steps button to define the number of recordings that are to take place within this range.

Note
The Lambda Steps button is not enabled unless you have selected a scan mode with wavelength dimension using the Mode button.

see Selecting a Scan Mode
see Defining the Begin Point for a Wavelength Series
see Defining the End Point for a Wavelength Series

Typical Applications
A wavelength series can be applied to determine the maximum emission of a fluorochrome. This is useful because the Stokes shift of the emission curve of a fluorochrome is dependent on each specimen that is applied. This then allows you to set the detection range precisely for a specific application.

5.1.18 Starting a Series Scan

Function
Use the Series Scan button to create an image series. This creates a multidimensional image data block of the specimen. The available dimensions for recording an image series are the three directions in space (x, y, z) as well as the dimensions of time (t) and wavelength (\( \lambda \)). This allows you to record a three-dimensional, spatial image stack consisting of xy-sections or xz-sections with the additional factor of time or wavelength.

Note
Before recording an image series, configure all required scan parameters using the Continuous Scan function to ensure optimal image quality.

see Starting a Continuous Scan

Before recording a spatial image series, configure the following settings:

- Select the scan mode using the Mode button.

see Selecting a Scan Mode

- Select the scan format using the Format button.

see Selecting a Scan Format
Set the desired z-position or y-position using the z/y-Position button or by using the corresponding rotary knob of the control panel.

see Setting the z/y-Position
see Controlling Functions from the Control Panel

Set and store the begin point for an image series using the Begin button or in the Series Scan Overview dialog window.

see Defining the Begin Point for a Spatial Series

Set the desired z-position or y-position using the z/y-Position button or by using the corresponding rotary knob of the control panel.

see Setting the z/y-Position
see Controlling Functions from the Control Panel

Set and store the end point for an image series using the End button or in the Series Scan Overview dialog window.

see Defining the End Point for a Spatial Series

Select the number of spatial sections using the Sections button.

see Defining the Number of Spatial Sections

When you have finished configuring these settings, press the Series Scan button.
You can track the recording process of the image stack in the Series Scan Overview dialog window.

Before recording a time series, configure the following settings:

Select a scan mode with time dimension using the Mode button.

see Selecting a Scan Mode

Select the scan format using the Format button.

see Selecting a Scan Format

Set the desired z-position or y-position using the z/y-Position button or by using the corresponding rotary knob of the control panel.

see Setting the z/y-Position
see Controlling Functions from the Control Panel

Set the number of recordings, the pause interval between scans and the complete recording time.

see Configuring a Time Series

When you have finished configuring these settings, press the Series Scan button.

Before recording a wavelength series, configure the following settings:

Select a scan mode with wavelength dimension using the Mode button.

see Selecting a Scan Mode
Select the scan format using the Format button.  
\[\text{See Selecting a Scan Format}\]

Define the wavelength at which you want the wavelength series to begin.  
\[\text{See Defining the Begin Point for a Wavelength Series}\]

Define the wavelength at which you want the wavelength series to end.  
\[\text{See Defining the End Point for a Wavelength Series}\]

Select the desired number of recordings between the begin and end points of the wavelength series.  
\[\text{See Setting the Number of Wavelength Steps}\]

5.1.19 Selecting Unidirectional or Bidirectional Scan

Function
If you click the Unidirectional/ Bidirectional Scan button, bidirectional scan mode is enabled. If this button is not clicked, unidirectional scan mode is automatically set.

In unidirectional scan mode, each line is scanned from left to right. No data is recorded while the laser beam is being guided to the starting point of the next line. In bidirectional scan mode, the first line is scanned from left to right and the second from right to left. In other words, the return run, or flyback, of the laser beam is implemented for recording data too, thus increasing the scan speed when using bidirectional scan mode.

If bidirectional scan mode is active, you can double the scan speed selected with the Speed button:

<table>
<thead>
<tr>
<th>Unidirectional</th>
<th>Bidirectional</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>Currently unavailable</td>
</tr>
<tr>
<td>400</td>
<td>800</td>
</tr>
<tr>
<td>800</td>
<td>1600</td>
</tr>
<tr>
<td>1000</td>
<td>2000</td>
</tr>
</tbody>
</table>

\[\text{See Selecting a Scan Speed}\]
In order to accurately align the pixels of the forward sweep and flyback, the phase between the forward sweep and the flyback can be adjusted. To do so, use the Phase button or the corresponding rotary knob of the control panel.

**Note**

If the speed is set to 800 or 1000, the maximum scan field can no longer be scanned because of technical, device-related reasons. The system switches automatically to zoom factor 2 and zoom factor 4 respectively.

### 5.1.20 Adjusting the phase

**Function**

Recording images in bidirectional scan mode can result in a phase shift between the forward sweep and flyback of the scanning beam. Click the Phase button to open a dialog window which you can use to correct the shift:

- Use the mouse to move the slide on the scale until the pixel shift in the image disappears.

You can also adjust the phase using the corresponding rotary knob of the control panel.

**Additional Information**

For each zoom factor, a phase adjustment has already been carried out by the factory, and the corresponding values have also been set. Based on the temperature response of mechanical and electronical devices, a slight deviation in the adjusted standard values can result during operation, which can be readjusted with this function.
5.1.21 Applying the Parameter Setting of an Experiment

Function

Use the Apply button to use the hardware settings of a previous experiment for recording a new experiment. This lets you configure the settings for new image recordings with a single click with the scan parameters that have been optimally configured for a previous application.

- Activate the image data block that is configured with the settings you want to apply to the new experiment.
- Click the Apply button.

5.1.22 Recording an Image Using the Averaging Method

Function

The Average button applies an averaging method to the image recording. In this case, every individual image, i.e. every xy-section or xz-section, is scanned several times. For every sampling point, the arithmetical average is calculated from the repeatedly measured intensity values and represented in the result image. The method used here determines a consecutive average. This means every image recorded after the first image is calculated with the results of the previously displayed image and is displayed in the result image (dynamic average).

Clicking the Average button opens a dialog window that you can use to set how often a section is to be scanned. You can select from 1 to 64 scan repeats.

Typical Applications

Recording an image using the averaging method is primarily useful for suppressing noise. In fluorescence microscopy, weak fluorescent specimens result in little light reaching the detector. The resulting low photon count leads to noisy images. In such
cases, you can improve the signal-to-noise ratio by carrying out multiple recordings and determining averages of the image.

Note

Recording an image using the averaging method is not recommended for bleach-sensitive specimens. Repeated recordings and the resulting length of subjection to light can lead to the destruction of the specimen.

5.2 Software functions for data display

5.2.1 The Viewer Window

The default setting of the Viewer window consists of three main areas. The image window (4), in which the recorded images are displayed, is located in the middle. Button pads (1) and (2) can be arranged to the left and below the image window and the Experiment legend (3) to the right of it. It is possible to select other default layouts of the Viewer window and save user-defined configurations of it.

Button Pads (1) and (2)

By default, the button pad to the left of the image window contains the buttons for image viewing functions and the button pad below the image window contains the buttons used for scrolling through the individual images of an image series. Both button pads can be moved within the Viewer window or removed from it as separate windows. To do so, click on the double-lined edge of the button pad and drag it while keeping the mouse button depressed to the desired position.

Image Window (4)

If you place the mouse pointer at any position within the image window and then press the right mouse button, a context menu containing the following commands opens:
### Command Function

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send to</td>
<td></td>
</tr>
<tr>
<td>Experiment</td>
<td></td>
</tr>
<tr>
<td>Selection (raw)</td>
<td>This copies the raw data of a selected area in the image window as a new image in the current experiment.</td>
</tr>
<tr>
<td>Selection (snapshot)</td>
<td>This creates a new image in the current experiment from the snapshot of a selected area in the image window.</td>
</tr>
<tr>
<td>All (snapshot)</td>
<td>This creates a new image in the current experiment from the snapshot of the entire, current image window.</td>
</tr>
<tr>
<td>Printer</td>
<td></td>
</tr>
<tr>
<td>Selection</td>
<td>This prints the area selected in the image window.</td>
</tr>
<tr>
<td>All</td>
<td>This prints the entire, current image window.</td>
</tr>
<tr>
<td>Left buttons</td>
<td>This shows or hides the button pad to the left of the image window.</td>
</tr>
<tr>
<td>Bottom buttons</td>
<td>This shows or hides the button pad located below the image window.</td>
</tr>
<tr>
<td>LUT</td>
<td>This shows or hides the color look-up tables of the current image.</td>
</tr>
<tr>
<td>Legend</td>
<td>This shows or hides the Experiment legend.</td>
</tr>
<tr>
<td>Full screen</td>
<td>This enlarges the Viewer window to full screen.</td>
</tr>
<tr>
<td>Viewer Options</td>
<td>This opens the Viewer Options dialog window.</td>
</tr>
</tbody>
</table>

The **color look-up tables (5)** are displayed as color bars to the right of the image window. If you hold the mouse pointer over a color bar, grab points appear at the top and bottom of the color bar. You can use these grab points to limit the current color look-up table to a specific intensity range and to load a second color look-up table. This allows you to increase the contrast of the image graphically.

- Drag the top grab point down or the bottom grab point up.
- Double-click the area above or below the corresponding grab point.
- The Select LUT’s dialog window opens so that you can select a second color look-up table.
- The upper and lower intensity ranges are represented in the colors of the second color look-up table.

<see Selecting Color Look-Up Tables (LUT)>

**The Experiment Legend (3)**
Various image parameters of an image recording are registered in the Experiment legend. To select the parameters that you want displayed, click any area of the legend. This opens a list of all available entries. Then select the desired entry. If you hold the mouse pointer over any area within the Experiment legend and press the right mouse button, a context menu containing the following commands opens:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiment</td>
<td>This opens the Edit Legend dialog window, where you can specify a title for the legend, specify the number of legend entries or Clear all entries.</td>
</tr>
<tr>
<td>› Edit</td>
<td>This opens the Edit Legend dialog window, where you can specify a title for the legend, specify the number of legend entries or Clear all entries.</td>
</tr>
<tr>
<td>› Activate</td>
<td>This displays the Experiment legend in the Viewer window.</td>
</tr>
<tr>
<td>› Remove</td>
<td>This deletes the current Experiment legend.</td>
</tr>
<tr>
<td>Add Experiment tab</td>
<td>This creates a new Experiment legend in the Viewer window.</td>
</tr>
</tbody>
</table>

**The Hardware Legend**

The hardware settings for image recording are registered in the Hardware legend. To open the legend, select the Hardware Legend option from the View menu. To select the entries that you want displayed in the legend, click the Edit button. This opens the Edit Legend Entries dialog window:

- The Available Entries list box shows all available entries. Select the entries that you want displayed in the legend. Then click Add to carry the selected entries over into the Show entries list box.
- The Show entries list box contains the entries that are to be displayed in the legend. Use the Remove button to remove entries from being displayed in the legend.
- Use the Move up and Move down buttons to shift one or more than one entry up or down in the list.
- You can use the Edit grid color and Edit background color buttons to modify the color of the frame and background of the legend.

The Hardware legend is aligned automatically along the right edge of the user interface. You can change however the size and position of the legend as desired:

- To change the width of the legend, use the mouse pointer to drag the edge to the position you desire.
- To change the position of the legend, double-click on the double-lined edge of the legend or click the icon once. This releases the legend from the user interface, turning it into a window. Now you can drag the legend to any position by pressing and holding the left mouse button.
Note

If the legend has been enlarged to cover the entire width of the user interface, you first have to shrink the height of it in order to drag it back to the edge of the user interface.

Option New Window

You can open a second Viewer window containing the same image as the currently open Viewer window by clicking the New Window option in the Window menu. This command does not create a new experiment, but rather opens a second view of the current image data. This feature is useful for viewing different representations of the same image data at the same time. Sequential numbers are added behind the file extension to distinguish between the resulting copies of the current Viewer window.

5.2.2 The Viewer Options Dialog Window, 3D Icon

Function

Click on Viewer Options in the View menu to open a dialog window where you can modify the basic settings for various functions. The left side of this dialog window shows the icons corresponding to the functions and the right side shows the related registers. When you open the dialog, it contains the icons of the functions that you are currently using. Click Show all to view all icons.

The Navigation register displays the numerical values of the actions that are carried out using the Rotate, Move and Zoom buttons (and the mouse pointer).

Use the Rotation field to tilt a 3D view in all three spatial directions by modifying the angular degrees of the three axes. The 3D view is rotated around a fixed point, which is located in the center of the image. To best understand the rotation function, modify the angle of one axis at a time, while leaving the other two axes set to 0.

<table>
<thead>
<tr>
<th>Rotation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>X from 0° to 45°</td>
<td>The 3D view is rotated 45° around the fixed point in the direction of the negative z-axis.</td>
</tr>
<tr>
<td>Y from 0° to 45°</td>
<td>The 3D view is rotated 45° around the fixed point in the direction of the negative x-axis.</td>
</tr>
<tr>
<td>Z from 0° to 45°</td>
<td>The 3D view is rotated 45° around the fixed point in the direction of the negative y-axis.</td>
</tr>
</tbody>
</table>

see Rotating the 3D View
Use the Translation field to shift a 3D view to the right or left, up or down and enlarge or shrink it by modifying the coordinate values. Use the dot as the decimal placeholder.

<table>
<thead>
<tr>
<th>Translation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Positive values shift the 3D view to the right, negative to the left.</td>
</tr>
<tr>
<td>Y</td>
<td>Positive values enlarge the 3D view, negative shrink it.</td>
</tr>
<tr>
<td>Z</td>
<td>Positive values shift the 3D view up, negative down.</td>
</tr>
</tbody>
</table>

Use the Predefined field to change the viewing perspective of the image to Top view or Side view by clicking these buttons respectively.

see Moving the 3D View
see Zooming the 3D View

In the Display register, click one of the listed commands to show or hide the corresponding graphic element of the 3D view in the Viewer window:

<table>
<thead>
<tr>
<th>Graphic Elements</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show LUT</td>
<td>Show the selected color look-up table on the z-axis.</td>
</tr>
<tr>
<td>Show scale</td>
<td>Show the scale.</td>
</tr>
<tr>
<td>Show bounding box</td>
<td>Show the bounding box, which limits the measurement volume.</td>
</tr>
<tr>
<td>Show axes</td>
<td>Show the coordinate axes.</td>
</tr>
<tr>
<td>Show data during 3D motion</td>
<td>Show the image data while the 3D view is being rotated, shifted, enlarged or shrunken.</td>
</tr>
</tbody>
</table>

5.2.3 The Viewer Options Dialog Window, Display Icon

Function

Click on Viewer Options in the View menu to open a dialog window where you can modify the basic settings for various functions. The left side of this dialog window shows the icons corresponding to the functions and the right side shows the related registers. When you open the dialog, it contains the icons of the functions that you are currently using. Click Show all to view all icons.
In the **Settings register** select the Display field to zoom in on and zoom out of the image displayed in the Viewer window using the graphical zoom function.

<table>
<thead>
<tr>
<th>n-1</th>
<th>Zooms in on the image by displaying n pixel as 1 pixel in the result image.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>The image is displayed in the original size.</td>
</tr>
<tr>
<td>1-n</td>
<td>Zooms out of the image by displaying 1 pixel as n pixel in the result image.</td>
</tr>
</tbody>
</table>

**Note**

*The Leica Confocal Software provides three different zoom features: the graphical zoom, the 3D zoom and the electronic zoom.*

See [Zooming the 3D View](#)  
See [The Electronic Zoom](#)

In the same register click one of the boxes to show or hide the corresponding graphic element in the Viewer window:

<table>
<thead>
<tr>
<th>Scale</th>
<th>Displays a scale bar with unit of length in the Viewer window.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid</td>
<td>Applies a grid to the image displayed in the Viewer window.</td>
</tr>
</tbody>
</table>

The length of the scale bar is calculated depending on the selected objective, electronic zoom and beam expander.

You can use the **Movie register** to set the speed for running the film sequence of an image series. You can choose speeds from 6 images per minute to 25 images per second.

Use the mouse to drag the slide on the scale to the desired value.

See [Starting and Ending a Film](#)
5.2.4 The Viewer Options Dialog Window, Surface Icon

**Function**
Click on Viewer Options in the View menu to open a dialog window where you can modify the basic settings for various functions. The left side of this dialog window shows the icons corresponding to the functions and the right side shows the related registers. When you open the dialog, it contains the icons of the functions that you are currently using. Click Show all to view all icons.

In the Render Mode field of the Visualization register, you can select whether the 3D view is to be generated in surface, wireframe or isolines mode:

<table>
<thead>
<tr>
<th>Render Mode</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surface</td>
<td>The blank spaces between the pixels are filled in with surface.</td>
</tr>
<tr>
<td>Wireframe</td>
<td>All pixels are linked with lines, while the blank spaces remain free.</td>
</tr>
<tr>
<td>Isolines</td>
<td>Pixels that correspond to values of the same intensity are surrounded by a curve.</td>
</tr>
</tbody>
</table>

In the Projection Type field, you can select the perspective to be used for displaying the 3D view:

<table>
<thead>
<tr>
<th>Projection Type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perspective</td>
<td>The 3D view is displayed in central perspective.</td>
</tr>
<tr>
<td>Parallel</td>
<td>The 3D view is displayed in parallel perspective.</td>
</tr>
</tbody>
</table>

In the Stretch Height (factor) field you can vary the scaling factor in the z-direction, thus stretching or shrinking the height of the 3D view.

Use the Downsample rate field to reduce the density of data of the 3D view to increase the speed of image processing. At a pixel density of 1:1, all measured intensity values are displayed in the image. At a pixel density of 1:2, only every second measured intensity value is used in the image.

Use the Isoline Interval field to define a distance for separating the individual isolines in µm. This allows you to limit the number of isolines in the 3D view.
Use the Isoline Detail Level field to enter a limiting value, specifying that only isolines of a particular length are to be displayed in the 3D view. This limits the displayed isolines to those which correspond to an intensity value that has a specific frequency of occurrence.

▶ see Creating the 3D View

5.2.5 Viewing Detection Channel 1

Function

Clicking the Channel 1 button displays the image data that have been recorded in detection channel 1 in the Viewer window. You can assign any of several color look-up tables to the detection channel. This setting can be changed both in the result image and while the image is being recorded. To do so, open the Select Look-up Tables dialog window. There are two ways of opening the dialog window:

- Click the Select Look-up Tables button.
- Hold the mouse pointer over any position in the Viewer window. Click the right mouse button. Click on the LUT item in the context menu that appears. The color bars for the active detection channels appear in the Viewer window. Double-click the corresponding color bar.

▶ see Selecting Color Look-Up Tables (LUT)

Note

This method of assigning color look-up tables only influences the currently displayed image. As soon as you start a new scan, the color look-up tables configured in the Beam Path Setting dialog window are applied again.

▶ see Setting the Beam Path
5.2.6 Viewing Detection Channel 2

**Function**
Clicking the Channel 2 button displays the image data that have been recorded in detection channel 2 in the Viewer window. You can assign any of several color look-up tables to the detection channel. This setting can be changed both in the result image and while the image is being recorded. To do so, open the Select Look-up Tables dialog window. There are two ways of opening the dialog window:

- Click the Select Look-up Tables button.
- Hold the mouse pointer over any position in the Viewer window. Click the right mouse button. Click on the LUT item in the context menu that appears. The color bars for the active detection channels appear in the Viewer window. Double-click the corresponding color bar.

See Selecting Color Look-Up Tables (LUT)

**Note**
This method of assigning color look-up tables only influences the currently displayed image. As soon as you start a new scan, the color look-up tables configured in the Beam Path Setting dialog window are applied again.

See Setting the Beam Path

5.2.7 Viewing Detection Channel 3

**Function**
Clicking the Channel 3 button displays the image data that have been recorded in detection channel 3 in the Viewer window. You can assign any of several color look-up tables to the detection channel. This setting can be changed both in the result image and while the image is being recorded. To do so, open the Select
Look-up Tables dialog window. There are two ways of opening the dialog window:

- Click the Select Look-up Tables button.
- Hold the mouse pointer over any position in the Viewer window. Click the right mouse button. Click on the LUT item in the context menu that appears. The color bars for the active detection channels appear in the Viewer window.

Double-click the corresponding color bar.

see Selecting Color Look-Up Tables (LUT)

Note

This method of assigning color look-up tables only influences the currently displayed image. As soon as you start a new scan, the color look-up tables configured in the Beam Path Setting dialog window are applied again.

see Setting the Beam Path

5.2.8 Viewing Detection Channel 4

Function

Clicking the Channel 4 button displays the image data that have been recorded in detection channel 4 in the Viewer window. You can assign any of several color look-up tables to the detection channel. This setting can be changed both in the result image and while the image is being recorded. To do so, open the Select Look-up Tables dialog window. There are two ways of opening the dialog window:

- Click the Select Look-up Tables button.
- Hold the mouse pointer over any position in the Viewer window. Click the right mouse button. Click on the LUT item in the context menu that appears. The color bars for the active detection channels appear in the Viewer window.

Double-click the corresponding color bar.

see Selecting Color Look-Up Tables (LUT)

Note

This method of assigning color look-up tables only influences the currently displayed image. As soon as you start a new scan, the
color look-up tables configured in the Beam Path Setting dialog window are applied again.

[see Setting the Beam Path]

5.2.9 Viewing Detection Channel 5

Function
Clicking the Channel 5 button displays the image data that have been recorded in detection channel 5 in the Viewer window. You can assign any of several color look-up tables to the detection channel. This setting can be changed both in the result image and while the image is being recorded. To do so, open the Select Look-up Tables dialog window. There are two ways of opening the dialog window:

- Click the Select Look-up Tables button.
- Hold the mouse pointer over any position in the Viewer window. Click the right mouse button. Click on the LUT item in the context menu that appears. The color bars for the active detection channels appear in the Viewer window. Double-click the corresponding color bar.

[see Selecting Color Look-Up Tables (LUT)]

Note
This method of assigning color look-up tables only influences the currently displayed image. As soon as you start a new scan, the color look-up tables configured in the Beam Path Setting dialog window are applied again.

[see Setting the Beam Path]
5.2.10 Selecting Color Look-Up Tables (LUT)

Function
Use the Look-up Tables button to open a dialog window, which you can use to assign color look-up tables to the five detection channels. The color look-up tables can be configured both in the result image and while the image is being recorded:

- Click the detection channel to which you want to assign a new color look-up table in the Select Channel field.
- Select the desired color look-up table in the Select LUT field.
- Click Apply to check the results in the Viewer window.

It is also possible to open the Select LUT's dialog window from the Viewer window.

- Hold the mouse pointer over any position in the Viewer window. Then push the right mouse button. Click on the LUT item in the context menu that appears.
- The color bars for the active detection channels appear in the Viewer window to the right of the image window. Double-click one of the color bars.

Loading a second color look-up table
If you hold the mouse pointer over a color bar, grab points appear at the top and bottom of the color bar. You can use these grab points to limit the current color look-up table to a specific intensity range and to load a second color look-up table:

- Drag the top grab point down or the bottom grab point up.
- Double-click the area above or below the corresponding grab point.
- The Select LUT’s dialog window opens so that you can select a second color look-up table.
- The upper and lower intensity ranges are represented in the colors of the second color look-up table.

Note
This method of assigning color look-up tables only influences the currently displayed image. As soon as you start a new scan, the color look-up tables configured in the Beam Path Setting dialog window are applied again.
Typical Applications
Generally the selection of a suitable color look-up table for a specific use depends on the user's own judgment and needs. Experience shows however that certain color look-up tables are particularly useful for specific uses.

<table>
<thead>
<tr>
<th>Color Look-Up Table</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>This is commonly used for recording specimens that have been marked with FITC, Cy2, DTAF or other similar fluorochromes, which emit within the green spectral range.</td>
</tr>
<tr>
<td>Red</td>
<td>This is commonly used for recording specimens that have been marked with TRITC, Texas Red, Cy3, Rodamin or other similar fluorochromes, which emit within the red spectral range.</td>
</tr>
<tr>
<td>Blue</td>
<td>This is commonly used for recording specimens that have been marked with UV fluorochromes such as DAPI or Hoechst or other similar fluorochromes, which emit within the blue spectral range.</td>
</tr>
<tr>
<td>Gray</td>
<td>This is commonly used for displaying transmission recordings.</td>
</tr>
<tr>
<td>P. Color 1, 2, 3, 4, 5, 6</td>
<td>This is commonly used for recording specimens that have been marked with pH-sensitive or ion-sensitive fluorochromes and for displaying time series.</td>
</tr>
<tr>
<td>Geo (Land), Geo (Sea), Geo (Land &amp; Sea), R &amp; B</td>
<td>These are recommended for generating topographical images, i.e. for mapping surface structures. Geo Land &amp; Sea is especially useful for visualizing depths and graduations.</td>
</tr>
<tr>
<td>Glow, Glow (Over), Glow (Under), Glow (Over &amp; Under)</td>
<td>These are recommended for optimizing image contrast (the offset and gain of the detectors). Glow Over highlights in blue intensities at the upper end of the table while Glow Under represents in green intensities at the lower end of the table. Glow Over and Under is a combination of these two color tables.</td>
</tr>
<tr>
<td>Cyan, Magenta, Yellow</td>
<td>These are recommended for printing images. The CMY(K) colors are generally used for the printer system color output. RGB colors such as the other color look-up table used here are applied generally for color representation on monitors. Because these two color systems vary greatly, the colors in the CMY(K) representation can differ strongly from those used in the monitor representation.</td>
</tr>
</tbody>
</table>

All color look-up tables are also available with inverse color flow, meaning high intensities are represented as dark and low intensities light.
5.2.11 Viewing a Single Image

**Function**
Click the Single button to view only one detection channel or several detection channels in only one image in the Viewer window. The following display modes are available depending on the other options you enable simultaneously.

<table>
<thead>
<tr>
<th>Button Combination</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single + Channel 1 / 2 / 3 / 4 / 5</td>
<td>Only the selected detection channel is displayed; for an image series, the first image of the selected detection channel is displayed.</td>
</tr>
<tr>
<td>Single + Gallery + Channel 1 / 2 / 3 / 4 / 5</td>
<td>All individual images in an image series are displayed for the selected detection channel only.</td>
</tr>
<tr>
<td>Single + Overlay + Channel 1 / 2 / 3 / 4 / 5</td>
<td>A single overlay image is generated from all selected detection channels; for an image series, the first image of each selected detection channel is used.</td>
</tr>
<tr>
<td>Single + Gallery + Overlay + Channel 1 / 2 / 3 / 4 / 5</td>
<td>Based on the number of individual images in an image series, overlay images are generated from all selected detection channels.</td>
</tr>
</tbody>
</table>

**Note**
The Single and Tiled buttons cannot be enabled simultaneously because they carry out opposing functions.

5.2.12 Viewing a Multiple Image

**Function**
If you click the Tiled button, the detection channels are displayed separately in the Viewer window. The following display modes are available depending on the other options you enable simultaneously.
### Button Combination Display

<table>
<thead>
<tr>
<th>Button Combination</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tiled + Channel 1 / 2 / 3 / 4 / 5</td>
<td>All selected detection channels are displayed separately; in the case of image series, the first image in each is applied.</td>
</tr>
<tr>
<td>Tiled + Gallery + Channel 1 / 2 / 3 / 4 / 5</td>
<td>All individual images in an image series are displayed for all selected detection channels.</td>
</tr>
<tr>
<td>Tiled + Overlay + Channel 1 / 2 / 3 / 4 / 5</td>
<td>All selected detection channels are displayed both separately and, in an overlay image, together. In the case of image series, the first image in each is applied.</td>
</tr>
<tr>
<td>Tiled + Gallery + Overlay + Channel 1 / 2 / 3 / 4 / 5</td>
<td>All individual images of an image series are displayed both separately for all selected detection channels and, in overlay images, together.</td>
</tr>
</tbody>
</table>

**Note**

*The Tiled and Single buttons cannot be enabled simultaneously because they carry out opposing functions.*

### 5.2.13 Viewing a Multiple Image

**Function**

If you click the Tiled button, the detection channels are displayed separately in the Viewer window. The following display modes are available depending on the other options you enable simultaneously.

<table>
<thead>
<tr>
<th>Button Combination</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tiled + Channel 1 / 2 / 3 / 4 / 5</td>
<td>All selected detection channels are displayed separately; in the case of image series, the first image in each is applied.</td>
</tr>
<tr>
<td>Tiled + Gallery + Channel 1 / 2 / 3 / 4 / 5</td>
<td>All individual images in an image series are displayed for all selected detection channels.</td>
</tr>
<tr>
<td>Tiled + Overlay + Channel 1 / 2 / 3 / 4 / 5</td>
<td>All selected detection channels are displayed both separately and, in an overlay image, together. In the case of image series, the first image in each is applied.</td>
</tr>
</tbody>
</table>
All individual images of an image series are displayed both separately for all selected detection channels and, in overlay images, together.

Note

The Tiled and Single buttons cannot be enabled simultaneously because they carry out opposing functions.

5.2.14 Viewing an Overlay Image

Function

Click the Overlay button to display all selected detection channels together in an overlay image in the Viewer window. The following display modes are available depending on the other options you enable simultaneously.

<table>
<thead>
<tr>
<th>Button Combination</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single + Overlay + Channel 1 / 2 / 3 / 4 / 5</td>
<td>A single overlay image is generated from all selected detection channels; for an image series, the first image of each selected detection channel is used.</td>
</tr>
<tr>
<td>Gallery + Single + Overlay + Channel 1 / 2 / 3 / 4 / 5</td>
<td>Based on the number of individual images in an image series, overlay images are generated from all selected detection channels.</td>
</tr>
<tr>
<td>Tiled + Overlay + Channel 1 / 2 / 3 / 4 / 5</td>
<td>All selected detection channels are shown separately as well as together in an overlay image. In an image series, the first image is used.</td>
</tr>
<tr>
<td>Tiled + Gallery + Overlay + Channel 1 / 2 / 3 / 4 / 5</td>
<td>All individual images of an image series are displayed both separately for all selected detection channels and, in overlay images, together.</td>
</tr>
</tbody>
</table>

Use the Viewer Options dialog window to select from three methods of color mixing for generating an overlay image:

- From the View menu, select Viewer Options.
- Click the Images icon and then click the Overlay register.

see The Viewer Options dialog window, Images Icon
5.2.15 Viewing the First Image of a Series

Function
You can view the individual images of an image series as a film sequence. Click First to jump to the first image in the series.

Note
If the Gallery button is enabled, the First and Last, Next and Previous and Play/Stop buttons are disabled and displayed in gray. The Gallery button is used to show all of the individual images of an image series and does not allow film sequence mode.

5.2.16 Viewing the Next Image in a Series

Function
You can view the individual images of an image series as a film sequence. Click Next to jump to the next image in the series.

Note
If the Gallery button is enabled, the Next and Previous, First and Last and Play/Stop buttons are disabled and displayed in gray. The Gallery button is used to show all of the individual images of an image series and does not allow film sequence mode.
5.2.17 Viewing the Previous Image in a Series

Function
You can view the individual images of an image series as a film sequence. Click Previous to jump to the previous image in the series.

Note
If the Gallery button is enabled, the Next and Previous, First and Last and Play/Stop buttons are disabled and displayed in gray. The Gallery button is used to show all of the individual images of an image series and does not allow film sequence mode.

5.2.18 Viewing the Last Image of a Series

Function
You can view the individual images of an image series as a film sequence. Click Last to jump to the last image in the series.

Note
If the Gallery button is enabled, the First and Last, Next and Previous and Play/Stop buttons are disabled and displayed in gray. The Gallery button is used to show all of the individual images of an image series and does not allow film sequence mode.
5.2.19 Starting and Ending a Film

Function
You can view the individual, recorded images of an image series as a film sequence. Use the Play/Stop button to start and stop the film. The speed of the film, i.e. the number of individual images per unit of time, is variable and can be set in the Viewer Options dialog window:

- From the View menu, select Viewer Options.
- Click the Display icon and then on the Movie register.

Note
If the Gallery button is enabled, the Play/Stop, First and Last, Next and Previous buttons are disabled and displayed in gray. The Gallery button is used to show all of the individual images of an image series and does not allow film sequence mode.

5.2.20 Viewing a Series Image

Function
If you click the Gallery button, all of the individual images in an image series are displayed in the Viewer window. The following display modes are available depending on the other options you enable simultaneously.

<table>
<thead>
<tr>
<th>Button Combination</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gallery + Single + Channel 1 / 2 / 3 / 4 / 5</td>
<td>All individual images in an image series are displayed for the selected detection channel only.</td>
</tr>
</tbody>
</table>
5.2.21 Projecting an Image Stack

Function
Use the Projection function to select or calculate specific intensity data from an image stack, i.e. a series of xy or xz-sections, and display them in a two-dimensional image. This function examines the sampling points (voxels) that are superimposed along the z-axis throughout all optical sections. From each of these columns of sampling points, the intensity value that is met by the selection criterion or the calculated intensity value is displayed in the two-dimensional projection image as the representative of all values within the column.

Three different projection types are available: the maximum projection, the mean projection and the transparent projection.

- The maximum projection uses the maximum intensity value as the representative.
- The average projection uses the arithmetical mean of the intensity values as the representative.
- The transparent projection uses a weighted mean of the intensity values as the representative. The weighting is composed of two factors. The first factor is the result of the ratio of each measured intensity value to the maximum possible intensity (scaling factor). The second factor takes into account the weight of the previously measured intensity value. The higher the intensity of the previously measured sampling point, the greater the weight is and the less the subsequently measured sampling points will influence the calculation.

Use the Viewer Options dialog window to select one of the projection types and configure any necessary options:

- From the View menu, select Viewer Options.
Click the Images icon and then click the Projections register.

See The Viewer Options Dialog Window, Images Icon

Note

Note the difference between a maximum projection and a topographical image, which is generated from intensity maximums. In a maximum projection, the intensity maximums are assigned color values directly. In a topographical image based on intensity maximums, the intensity maximums are assigned real z-positions of the individual sampling points first and then are color-coded.

5.2.22 Creating a Topographical Image

Function
Use the Topography function to select specific intensity data from an image stack, i.e. a series of xy or xz-sections, and transfer them into a two-dimensional topographical image. This function examines the sampling points (voxels) that are superimposed along the z-axis throughout all optical sections. From each of these columns of sampling points, only the intensity value that is met by the selection criterion is displayed in the two-dimensional topographical image as the representative of all values within the column.

You can make your selection based on either the maximum intensity or the center of mass of the measured intensities. If you want to represent the intensity maximums in the topographical image, only the sampling point at which the maximum intensity was measured is selected. When determining the center of mass, a mean value is calculated from all superimposed sampling points (the center of mass of the area that is limited by the curve of the measured intensity values).

The intensity maximum or center of mass is then assigned the real z-position of the corresponding sampling point and then color-coded. Based on this assignment, a topographical image maps the real surface structure of the specimen. Using the default settings, higher structures appear light and deeper structures dark.

Use the Viewer Options dialog window to set the selection criterion for the topographical image:
From the View menu, select Viewer Options.

Click the Images icon and then click the Topography register.

see The Viewer Options Dialog Window, Images Icon

By applying a second step, you can display the topographical image as a three-dimensional graphical image using the 3D View function.

see Creating the 3D View

Typical Applications
Displaying the image data in a topographical image is especially informative in material scientific research. For the application of quantification functions, the topography function is indispensable.

5.2.23 Viewing the Original Image

Function
Click the Original button to reset a projection image or topographical image. The Viewer window then displays the recorded raw data of the image again.

5.2.24 Creating the 3D View

Function
Use the 3D View button to display a two-dimensional data record three-dimensionally. When viewing an image series, the data record of the series that is currently being viewed in the Viewer window is always the one applied. You can display a single xy-section or xz-section from the raw data or a result image, such as a topographical image or projection image, in the 3D view. Depending on the dimension represented or calculated in the source image, either intensity values or height values are mapped to the z-axis of the 3D view when the 3D view is generated.
Note

The spatial representation of intensity in a 3D view leads easily to the assumption that the topography of the specimen is being represented. Note however that you can only display the real surface structure of a specimen if you have generated a topographical image first.

See Creating a Topographical Image

The 3D view can be generated in three different modes: surface, wireframe or isolines. Set the display mode in the Viewer Options dialog window:

- From the View menu, select Viewer Options.
- Click the Surface icon and then the Visualization register.

See The Viewer Options Dialog Window, Surface Icon

Note

A separate 3D view is created for each detection channel. Therefore it is not possible to generate a single 3D view from one overlay image (Overlay button).

5.2.25 Rotating the 3D View

Function

Use the Rotate button to rotate a 3D view in all three spatial directions. Note that the 3D view is rotated around a fixed point, which is located in the center of the image.

- Hold the mouse pointer over any position in the 3D view.
- Press and hold the left mouse button.
- Move the mouse pointer in the direction in which you want to rotate the 3D view.

Note

While the 3D view is being turned, the resolution of the image is
decreased in order to speed up processing. When the left mouse button is released, the image is displayed with its original resolution.

As an alternative to rotating a 3D view manually, the Viewer Options dialog window also provides the option of specifying the angles of rotation for the three spatial axes:

- From the View menu, select Viewer Options.
- Click the 3D icon and then click the Navigation register.
- You can then specify the angles of rotation for all three axes in the Rotation field.

[see The Viewer Options Dialog Window, 3D Icon]

### 5.2.26 Moving the 3D View

**Function**

Use the Move button to shift a 3D view

- Hold the mouse pointer over any position in the 3D view.
- Press and hold the left mouse button.
- Move the mouse pointer in the direction in which you want to move the 3D view.

**Note**

While the 3D view is being moved, the resolution of the image is decreased in order to speed up processing. When the left mouse button is released, the image is displayed with its original resolution.

As an alternative to moving a 3D view manually, the Viewer Options dialog window also provides the option of specifying the coordinate values for the position of the image:

- From the View menu, select Viewer Options.
- Click the 3D icon and then click the Navigation register.
- Modify the coordinate values for the x-axis and z-axis in the Translation field.
5.2.27 Zooming the 3D View

**Function**

Use the Zoom button to magnify and shrink continuously a 3D view while maintaining the aspect ratio. This function only adjusts the scale of, i.e. zooms, the generated image. It cannot be used to improve its resolution.

<table>
<thead>
<tr>
<th>To zoom in on the 3D view</th>
<th>Click anywhere inside the image window of the Viewer window and, while pressing the left mouse button, drag the mouse pointer <strong>toward the lower edge</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>To zoom out of the 3D view</td>
<td>Click anywhere inside the image window of the Viewer window and, while pressing the left mouse button, drag the mouse pointer <strong>toward the upper edge</strong>.</td>
</tr>
</tbody>
</table>

**Note**

*While the 3D view is being zoomed, the resolution of the image is decreased in order to speed up processing. When the left mouse button is released, the image is displayed with its original resolution.*

As an alternative to zooming a 3D view manually, the Viewer Options dialog window also allows you to change the zoom scale by specifying numerical values:

- From the View menu, select Viewer Options.
- Click the 3D icon.
- You can then vary the zoom factor in the Navigation register by changing the y value in the Translation field.

**Note**

*The Leica Confocal Software provides three different zoom features: the 3D zoom, the electronic zoom and the graphical zoom.*
5.3 Software functions for measurements and analysis

5.3.1 Calculating a Histogram

Function
Use the Histogram function to graphically display the frequency at which a specific dimension occurs. The histogram is calculated from the data record selected in the Viewer window. The data record can be a single image or an image series from raw data or a processed image. Depending on the dimension represented in the image, either the distribution of intensity values (I) or height values (µm) is calculated in the histogram.

Clicking the Histogram button opens the Histogram viewer window, which displays a histogram curve for each detection channel and subsequent statistical calculations:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td># Pixel</td>
<td>The total number of pixels that are included in the calculation of the histogram. This corresponds to the configured scan format.</td>
<td></td>
</tr>
<tr>
<td>Mean</td>
<td>The arithmetical mean value</td>
<td>$\mu(I) = \frac{1}{N_{\text{Pixel}}} \sum I_i$</td>
</tr>
<tr>
<td>Maximum</td>
<td>Maximum value</td>
<td>Max (I)</td>
</tr>
<tr>
<td>Minimum</td>
<td>Minimum value</td>
<td>Min (I)</td>
</tr>
<tr>
<td>Variance</td>
<td>Variance</td>
<td>$\text{VAR}(I) = \frac{1}{N-1} \sum (I_i - \mu(I))^2$</td>
</tr>
<tr>
<td>Average Deviation</td>
<td>Average deviation</td>
<td>$\text{DISP}(I) = \frac{1}{N-1} \sum</td>
</tr>
</tbody>
</table>
### Table: Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Deviation</td>
<td>Standard deviation</td>
<td>$S(I) = \sqrt{VAR(I)} = \sqrt{\frac{1}{N-1} \sum_{i} (I_i - \mu(I))^2}$</td>
</tr>
<tr>
<td>Mean Energy</td>
<td>Average image energy</td>
<td>$I_{Mean}^2 = \frac{1}{N_{Pixel}} \sum_{i} I_i^2$</td>
</tr>
<tr>
<td>Root Mean Square (RMS)</td>
<td>Root mean square value</td>
<td>$I_{Mean}^2 = \sqrt{\frac{1}{N_{Pixel}} \sum_{i} I_i^2}$</td>
</tr>
<tr>
<td>Skewness</td>
<td>Skewness of the distribution</td>
<td>$Skew(I) = \frac{1}{N} \sum_{i} \left[ \frac{I_i - \mu(I)}{\sqrt{VAR(I)}} \right]^3$</td>
</tr>
</tbody>
</table>

Some of the parameters are specified in scientific exponential notation, e.g. Pixel = 3.28e+005 = 327680 (corresponds to a scan format of 640 x 512).

### Note

Using the maximum and minimum values of intensity, the gain values and offset values can be optimally configured for the detectors.

#### 5.3.2 Measuring a Profile in a Single Image

**Function**

Use the Profile function to measure a specific dimension over a line segment and display it graphically. The profile is measured from the data record selected in the Viewer window. The data record can be a single image or an image series from raw data or a processed image. Depending on the dimension represented in the image, either a measured curve of intensity values ($I$) or height values ($\mu m$) is calculated.

When you click the Profile button, the line segment to be measured appears in the Viewer window as a white line in the image. You can change the length and position of the line segment by clicking the line and, while clicking and holding the grab point with the left mouse button, dragging it to the desired position. The Profile viewer window opens, too, which displays a profile curve for each detection channel and subsequent statistical calculations:
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>The length of the measured</td>
<td>[ L = \sqrt{(x_2 - x_1)^2 + (y_2 - y_1)^2} ]</td>
</tr>
<tr>
<td></td>
<td>section</td>
<td></td>
</tr>
<tr>
<td>Mean Amplitude</td>
<td>The arithmetical mean</td>
<td>[ \mu(I) = \frac{1}{N_{Pixel}} \sum_i I_i ]</td>
</tr>
<tr>
<td>Maximum Amplitude</td>
<td>Maximum value</td>
<td>[ \text{Max (I)} ]</td>
</tr>
<tr>
<td>Minimum Amplitude</td>
<td>Minimum value</td>
<td>[ \text{Min (I)} ]</td>
</tr>
<tr>
<td>Average Deviation</td>
<td>Average deviation</td>
<td>[ \text{DISP (I)} = \frac{1}{N-1} \sum_i</td>
</tr>
<tr>
<td>Standard Deviation</td>
<td>Standard deviation</td>
<td>[ s(I) = \sqrt{\text{VAR (I)}} = \sqrt{\frac{1}{N-1} \sum_i (I_i - \mu(I))^2} ]</td>
</tr>
<tr>
<td>Variance</td>
<td>Variance</td>
<td>[ \text{VAR (I)} = \frac{1}{N-1} \sum_i (I_i - \mu(I))^2 ]</td>
</tr>
</tbody>
</table>

Some of the parameters are specified in scientific exponential notation, e.g. Variance = 1.88e+004 = 18800.
5.4 Software functions for documentation of data

5.4.1 Creating an Annotation Sheet

Function
Use the Annotation button to open a window in which you can prepare recorded images for presentation purposes. If you have opened the annotation sheet, the Snap, Line, Rectangle and Text buttons are also enabled. Use these buttons to copy the image loaded in the Viewer window into the annotation sheet, to highlight specific areas of the copied image with lines and rectangles and to enter an image comment into a text field.

see Copying an Image
see Drawing a Line
see Drawing a Rectangle
see Creating a Text Field

If you hold the mouse pointer over the annotation sheet and press the right mouse button, a context menu containing the following commands appears:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>Use this to insert a line of default size onto the annotation sheet.</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Use this to insert a rectangle of default size onto the annotation sheet.</td>
</tr>
<tr>
<td>Text</td>
<td>Use this to insert a text field with a default font onto the annotation sheet.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Use this to select from four magnifications for viewing the annotation sheet.</td>
</tr>
<tr>
<td>Grid</td>
<td>This displays a grid on the annotation sheet, which cannot be printed.</td>
</tr>
</tbody>
</table>

The Line, Rectangle and Text commands can be activated both from the context menu and by clicking their corresponding buttons.

Saved annotation sheets are given the *.ano file extension.
5.4.2 Copying an Image onto the Annotation Sheet

Function
If you click the Snap button, the image loaded in the Viewer window is copied onto the annotation sheet. If you mark the copied image and then press the right mouse button, a context menu containing the following commands appears:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original size</td>
<td>This displays the image in its original size.</td>
</tr>
<tr>
<td>Fit to page</td>
<td>This enlarges the image to the size of the annotation sheet.</td>
</tr>
<tr>
<td>Bring to front</td>
<td>This brings the image to the foreground.</td>
</tr>
<tr>
<td>Send to back</td>
<td>This sends the image to the background.</td>
</tr>
<tr>
<td>Delete</td>
<td>This deletes the image.</td>
</tr>
</tbody>
</table>

You can change the size of the image by dragging one of the image grab points. To move the image without changing its size, mark the image and move it while pressing the left mouse button.

Note
The Snap button can be applied only if an annotation sheet has been opened using the Annotation button first and the Viewer window has then been clicked.

5.4.3 Drawing a Line on the Annotation Sheet

Function
Use the Line button to draw a line on the annotation sheet. On the annotation sheet, click the position where you want the line to begin. Keeping the left mouse button depressed, drag the mouse pointer across the page to the position where you want
the line to end. If you mark the line and then press the right mouse button, a context menu containing the following commands appears:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style</td>
<td>This opens a dialog window where you can configure the style, thickness and length of the line.</td>
</tr>
<tr>
<td>Color</td>
<td>This opens a dialog window for selecting a color for the line.</td>
</tr>
<tr>
<td>Bring to front</td>
<td>This brings the line to the foreground.</td>
</tr>
<tr>
<td>Send to back</td>
<td>This sends the line to the background.</td>
</tr>
<tr>
<td>Delete</td>
<td>This deletes the line.</td>
</tr>
</tbody>
</table>

You can change the length of the line by dragging one of its grab points. To move the line without changing its size, click the center grab point and move the line while pressing and holding the left mouse button.

**Note**

*The Line button can be applied only if the annotation sheet has been opened using the Annotation button first.*

### 5.4.4 Drawing a Rectangle on the Annotation Sheet

**Function**

Use the Rectangle button to draw a rectangle on the annotation sheet. On the annotation sheet, click the position where you want the corner of the rectangle to be. Keeping the left mouse button depressed, drag the mouse pointer across the page to define the size of the rectangle. If you mark the rectangle and then press the right mouse button, a context menu containing the following commands appears:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style</td>
<td>This opens a dialog window where you can configure, among other options, the style and thickness of the line.</td>
</tr>
<tr>
<td>Color</td>
<td>This opens a dialog window for selecting a color for the rectangle.</td>
</tr>
<tr>
<td>Bring to front</td>
<td>This brings the rectangle to the foreground.</td>
</tr>
</tbody>
</table>
You can change the size of the rectangle by dragging one of the image grab points of the rectangle. To move the rectangle without changing its size, click in the middle of the rectangle and move it while pressing and holding the left mouse button.

**Note**

*The Rectangle button can be applied only if the annotation sheet has been opened using the Annotation button first.*

### 5.4.5 Printing

**Function**

You can trigger the print command either by clicking the Print button or from the Printer Selection dialog window. To open this dialog window, select the Print option in the File menu. The image loaded in the Viewer window or an annotation sheet can be printed.

When you initiate the Print command, the image currently loaded in the Viewer window or the currently open annotation sheet is printed using the default printer and default page layout. You can change these default settings in the Printer Selection dialog window to suit your needs. Use the following buttons provided in the dialog window to do so:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer setup</td>
<td>This opens the dialog window for selecting a printer and changing the</td>
</tr>
<tr>
<td></td>
<td>printer settings.</td>
</tr>
<tr>
<td>Print</td>
<td>This prints the image or the annotation sheet.</td>
</tr>
<tr>
<td>Background color</td>
<td>Use this to open a dialog window for selecting a background color for the</td>
</tr>
<tr>
<td></td>
<td>page.</td>
</tr>
<tr>
<td>Center on page</td>
<td>This centers the image on the page.</td>
</tr>
<tr>
<td>Fit to page</td>
<td>This option changes the size of the image to fit the size of the printable</td>
</tr>
<tr>
<td></td>
<td>area.</td>
</tr>
<tr>
<td>Aspect ratio</td>
<td>The height-to-width ratio remains the same when the size of the image</td>
</tr>
<tr>
<td></td>
<td>changes.</td>
</tr>
</tbody>
</table>
Use the Image field to change the height (Size Y) and width (Size X) of the image and to define a top margin (Offset Y) and a left margin (Offset X). The image size and margins cannot be modified if the Fit to page option is enabled. If you have enabled Center on Page, you can change the size but not the margins.

Check the results of your settings in the Print Preview field. Use the Page field to specify the height and width of the printable area (which is not identical to the paper size). The two bottom lines of the dialog window display the currently installed printer and configured paper size.

**Note**

Close the Printer Selection dialog window by clicking OK to save the new settings for the active Viewer window. This allows you to store different printer settings and page layouts for different images. However, these settings are not permanent and are lost when you exit the Leica Confocal Software.

**5.5 Softwarefunctions for data handling**

**5.5.1 Opening a File**

**Function**

With the Leica Confocal Software, you can open the following file types using the Open button:

<table>
<thead>
<tr>
<th>File Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiment (*.lei)</td>
<td>A Leica-specific, binary data format. When the experiment is loaded, both the image data and the experiment settings are loaded.</td>
</tr>
<tr>
<td>Annotation sheet (*.ano)</td>
<td>A Leica-specific, binary data format. The elements on the annotation sheet, such as images, texts and graphic images, are each available as individual objects.</td>
</tr>
<tr>
<td>Tiff files (*.tif)</td>
<td>These are Leica image files in single and multi Tiff format. External files in RGB-Tiff format can be loaded as well.</td>
</tr>
</tbody>
</table>
5.5.2 Saving a File

Function
Click the Save button to save the data of the current experiment (*.lei) or the current annotation sheet (*.ano).

If you use the Save button to save an experiment or annotation sheet for the first time, the Save As dialog window opens.

Note
It is easy to mistakenly overwrite your original data using the Save function. To avoid doing so, use the Save As function to save an experiment, which has already been saved once or more, under a new name.

5.5.3 Saving a File As

Function
Use the Save As button to save an experiment (*.lei) or annotation sheet (*.ano) while giving it a specific name and file type.

When saving an experiment, a folder is created at the file level with the name of the experiment. This folder then contains the description file (*.lei) for the experiment as well as the individual image files. The format of the description file is Leica-specific and binary. This file contains the parameter settings and the color information (in the form of color look-up tables) for each image belonging to the experiment.
The image files of an experiment can be saved in tif or raw format. The standard format, tif, also contains the experiment settings and the color information for the images. In the raw format, just the image data is saved.

**Typical Applications**

The advantage of the raw format is the smaller file size, which however is only significant for image recordings with relatively small amounts of data. For example if you record an image series with a large number of individual images but at a low scan format, you can save and open it faster in raw format than in tif.

### 5.5.4 Saving All Files

**Function**

Use the Save All button to save several experiments (*.lei) and annotation sheets (*.ano) one after the other while giving them a specific name and file type.

When saving an experiment, a folder is created at the file level with the name of the experiment. This folder then contains the description file (*.lei) for the experiment as well as the individual image files. The format of the description file is Leica-specific and binary. This file contains the parameter settings and the color information (in the form of color look-up tables) for each image belonging to the experiment.

The image files of an experiment can be saved in tif or raw format. The standard format, tif, also contains the experiment settings and the color information for the images. In the raw format, just the image data is saved.

**Typical Applications**

The advantage of the raw format is the smaller file size, which however is only significant for image recordings with relatively small amounts of data. For example if you record an image series with a large number of individual images but at a low scan format, you can save and open it faster in raw format than in tif.
5.5.5 Creating an Experiment

Function
Click the New Experiment button to open a new Viewer window, which creates a new experiment. An experiment is a file that consists of one or more individual images or image series. This allows you to keep several images, each recorded using different scan parameters, or edited versions of images in one experiment. The format of the experiment file (*.lei) is Leica-specific.

The Experiment Overview Viewer Window
To open the Experiment Overview viewer window, select the Experiment Overview option from the View menu. This viewer window displays the recorded images in a directory tree. Every newly created experiment appears in this viewer window with a file name consisting of Experiment followed by a sequential number and the *.lei extension. You can change file names and file extensions using the Save and Save as buttons.

see Saving a File
see Saving a File as...

Individual images that you have recorded using the Single Scan function are entered into the directory tree with the name Image followed by a sequential number. Image series that you have recorded using the Series Scan function are given names consisting of Series and a sequential number.

If you mark the name of an individual image or an image series and then press the right mouse button, a context menu containing the following commands appears:

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate</td>
<td>This displays the selected file in the Viewer window.</td>
</tr>
<tr>
<td>New Window</td>
<td>This opens a second viewer window for the currently loaded image.</td>
</tr>
<tr>
<td>Delete</td>
<td>This deletes the individual image or image series.</td>
</tr>
<tr>
<td>Properties</td>
<td>This displays file properties and certain scan parameters in a dialog window.</td>
</tr>
</tbody>
</table>
The Experiment Overview viewer window automatically appears at the left edge of the user interface. You can change however the size and position of the viewer window as desired:

- To change the width of the viewer window, use the mouse pointer to drag the edge to the position you desire.

- To change the position of the viewer window, double-click on the double-lined edge of the window or click the icon once. This releases the viewer window from the user interface. Now you can drag the viewer window to any position by pressing and holding the left mouse button.

**Note**

*If the viewer window has been enlarged to cover the entire width of the user interface, you first have to shrink the height of it in order to drag it back to the edge of the user interface.*

### 5.6 Software functions for customization

#### 5.6.1 Saving the Viewer Window as a Template

**Function**

Use the Template button to save a user-defined layout of the Viewer window as a template. The elements of the Viewer window which can be displayed or hidden, are the button pads, the color bars of the color look-up tables and the Experiment legend.

[see The Viewer Window](#)

Clicking the Template button opens a dialog window where you enter a name for the template. The configuration of the Viewer window is saved and always loaded if you open a file or create a new experiment.

**Additional Information**

Click Options in the Tools menu and then select the Viewer Template register to get access to default and user-defined templates. You can select one of the following default templates in the Leica Templates list field:
<table>
<thead>
<tr>
<th>Viewer Template</th>
<th>Layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewer (Pure)</td>
<td>The viewer window consists of the image window, only.</td>
</tr>
<tr>
<td>Viewer (LUT)</td>
<td>The viewer window consists of the image window and the color bars of the color look-up tables.</td>
</tr>
<tr>
<td>Viewer (Standard)</td>
<td>The viewer window consists of the button pads, the image window, the color bars of the color look-up tables and the Experiment legend.</td>
</tr>
</tbody>
</table>

In the Personal Templates list field, user-defined templates are registered. Use the buttons Add Active Viewer and Remove Template to save a new template or to delete an existing one.

Click Options in the Tools menu and then select the Workspace register to define whether, and if, how many Viewer windows are to be opened at start-up of the Leica Confocal Software.
6 Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aberration, chromatic</td>
<td>An optical image distortion conditional on the varying refraction of light rays of different wavelengths on a lens. Thus light rays of shorter wavelengths have longer focal distances than light rays of longer wavelengths.</td>
</tr>
<tr>
<td>Aberration, spherical</td>
<td>An optical image distortion conditional on the varying distance of paraxial light rays of the same wavelength from the optic axis. Light rays that travel through outer lens zones have shorter focal distances than rays that travel through the lens center (optic axis).</td>
</tr>
<tr>
<td>Achromat (achromatic objective)</td>
<td>Describes a correction class for objectives. The chromatic aberration for two wavelengths is corrected for objectives of this type. Usually an objective of this type is corrected to a wavelength below 500nm and above 600nm. Furthermore, the sine condition for one wavelength is met. The image curvature aberration is not corrected.</td>
</tr>
<tr>
<td>Airy disc</td>
<td>The Airy disc refers to the inner, light circle (surrounded by alternating dark and light diffraction rings) of the diffraction pattern of a point light source. The diffraction discs of two adjacent object points overlap some or completely, thus limiting the spatial resolution capacity.</td>
</tr>
<tr>
<td>Aliasing</td>
<td>An image distortion caused by a sampling frequency that is too low in relation to the signal frequency.</td>
</tr>
<tr>
<td>AOTF Acousto-Optical Tunable Filter</td>
<td>The acousto-optical tunable filter is an optic transparent crystal that can be used to infinitely vary the intensity and wavelength of radiated light. The crystal generates an internal ultrasonic wave field, the wavelength of which can be configured to any value. Radiated light is diffracted vertically to the ultrasonic wave field like through a grid.</td>
</tr>
<tr>
<td>Aperture, numerical</td>
<td>The aperture is the sine of the angle under which light enters into the front lens of a microscope objective; its symbol is NA. The aperture influences both the light gathering capacity and the resolution capacity of an objective. Since various media can be present between specimen and objective lens (such as the embedding medium for the specimen), the numerical aperture ((NA = n \times \sin \alpha)) is usually applied as the unit of measurement for the light gathering capacity and the resolution capacity.</td>
</tr>
<tr>
<td>Apochromat (apochromatic objective)</td>
<td>Describes a correction class for objectives. The chromatic aberration for three wavelengths is corrected for objectives of this type (usually 450nm, 550nm and 650nm) and the sine condition for at least two colors is met. The image curvature aberration is not corrected.</td>
</tr>
<tr>
<td>Bleaching, optical</td>
<td>The destruction of fluorochromes by intense lighting. In fluorescence microscopy, fluorochromes are excited with laser...</td>
</tr>
</tbody>
</table>
light to a high state of energy, the singlet state. When the excited molecules return to their normal energy state, a fluorescent signal is emitted. If the intensity of the excitation is too high however, the color molecules can change via intercrossing from a singlet state to a triplet state. Due to the significantly longer life of triplet states (phosphorescence), these excited molecules can react with triplet-oxide and be lost for further fluorescence excitation.

Confocality  
While the optical design of conventional microscopes results in the detection of both focussed and unfocussed image components, the confocal principle suppresses the structures outside of the focal plane of the microscope objective. To achieve this pinholes are implemented in optically conjugated locations in the optical path. They function as point light source (excitation pinhole) and point detector (detection pinhole). The diameter of the detection pinhole, along with the wavelength and numerical aperture of the objective being used, determines the axial extension of an optical section.

Curvature of image field  
The curved surface to which a microscopic image is to be clearly and distinctly mapped is described as image curvature aberration. It is conditional on the convex shape of the lens and makes itself apparent as an error due to the short focal distances of microscope objectives. Here the object image is not in focus both in the center and at the periphery at the same time. Objectives that are corrected for image curvature aberration are called plane objectives (plane = flat image field).

Dichroic  
Dichroic filters are interference filters at an angle of incidence of light of 45°. The transmissivity and reflectivity of dichroites depend on a specific wavelength of light. For an RSP 510 filter (reflection short pass), for example, the excitation light below 510 nm is reflected and the excitation light above this value is transmitted. The transmission values are generally between 80% and 90% and the reflection values between 90% and 95%.

Double dichroic  
Double dichroic filters are interference filters at an angle of incidence of light of 45°. The transmissivity and reflectivity of double dichroites depend on two specific wavelengths of light. For a double dichroite DD 488/568, for example, the excitation light at 488 nm and 568 nm is reflected and the excitation light above these values is transmitted. The transmission values are generally at 80% and the reflection values are between 90% and 95%.

Dry objective  
A microscopic objective used without immersion media. Between the objective lens and the specimen is air.

Fluorescence microscopy  
A light-optical contrast process for displaying fluorescent structures. Auto-fluorescent samples have a so-called primary fluorescence. They do not need to be enriched with additional, fluorescent substances. Secondary fluorescent substances, on the other hand, have to be treated with appropriate dyes or stains called fluorochromes. Specific dyeing methods additionally allow the precise localization of the stained structure elements of an object. Fluorescence microscopy allows both potential morphological examinations and the ability to carry out...
dynamic examinations on a molecular level.

**Fluorite objectives**

Describes a correction class for objectives. Fluorite lenses are semi-apochromatic, meaning their degree of correction lies between the achromatic and apochromatic.

**Immersion objective**

A microscopic objective, developed with the requirements for applying immersion media. The use of incorrect or no immersion medium with an immersion objective can lead to resolution loss and impairment of the correction.

**Neutral filter**

Neutral filters are semi-reflective glass plates. They are used to distribute the light path independent of wavelength. The incident light is partially reflected and partially transmitted. Neutral filters are usually placed at a 45° angle in the path of the beam. The ratings of a neutral filter are based on its reflectivity-to-transmissivity ratio. A neutral filter RT 30/70, for example, reflects 30% of the excitation light and transmits 70%.

**Pixel**

An acronym based on the words, picture and element. A pixel represents the smallest, indivisible picture element in a two-dimensional system. In this documentation, both the sampling points of the specimen as well as the picture points are referred to as pixels.

**Plan objectives, flatfield objectives**

Describes a correction class for objectives. The image curvature aberration is corrected for objectives of this type. Correcting this error requires lenses with stronger concave surfaces and thicker middles. Three types of plan objectives, planachromate, planapochromate and plan-fluorite, are based on the type of additional correction for chromatic aberration.

**Reflection short pass filter**

Reflection short pass filters are interference filters that transmit short-wave light while reflecting long-wave light. An optical reflection short pass filter is characterized by the reading of the wavelength edge at which the filter changes from transmission to reflection (50% threshold).

**Reflection long pass filter**

Reflection long pass filters are interference filters that reflect short-wave light but are transparent for long-wave light. An optical reflection long pass filter is characterized by the reading of the wavelength edge at which the filter changes from reflection to transmission (50% threshold).

**Refractive index**

The factor by which the light velocity in an optical medium is less than in a vacuum.

**Signal-to-noise ratio**

The ratio of signals detected in the specimen and the unwanted signals that are caused randomly by various optic and electronic components, which are also recorded by the detector.

**Stokes shift**

The Stokes shift is a central term in fluorescence microscopy. When fluorescent molecules are excited with light of a specific wavelength, they radiate light of another, longer wavelength. This difference between excitation light and fluorescent light is referred to as Stokes shift. Without Stokes shift, separating the high-intensity excitation light from the low-intensity fluorescence signals in a fluorescence microscope would not be possible.
**Triple dichroic**

Triple dichroic filters are interference filters at an angle of incidence of light of 45°. The transmissivity and reflectivity of triple dichroites depend on three specific wavelengths of light. For a triple dichroite TD 488/568/647, for example, the excitation light at 488 nm, 568 nm and 633 nm is reflected and the excitation light above these values is transmitted. The transmission values are generally at 80% and the reflection values are between 90% and 95%.

**Voxel**

An acronym based on the words, volume and pixel. A voxel represents the smallest, indivisible volume element in a three-dimensional system. In this documentation, both the volume elements of the specimen as well as the 3D picture points are referred to as voxels.

**Working distance**

The distance from the front lens of an objective to the focal point. The free working distance is defined as the distance between the front lens of the objective and the cover slip or uncovered sample. Usually objectives with large working distances have low numerical apertures, while high-aperture objectives have small working distances. If a high-aperture objective with a large working distance is desired, the diameter of the objective lens has to be made correspondingly large. These, however, are usually low-correction optic systems, because maintaining extreme process accuracy through a large lens diameter can only be achieved with great effort.